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Preface

THANK YOU - For purchasing the Radlink LaserPro16 — Laser Film Digitizer.
This manual will assist you in learning all the functions of your Laser Digitizer,
from installation through operation. Please read each section carefully.

SAFETY - Read and follow all warning and safety instructions in this User’s
Manual and marked on the product. Not following the instructions may be
hazardous or illegal.

INSTALLATION - Follow the Installation Instructions in this manual carefully.
Use only the supplied accessories. If parts are missing, contact Radlink
before proceeding.

INTERFERENCE - This equipment has been tested and found to comply with
the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful
interference in a commercial installation. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause interference to radio
communications.

Properly shielded and grounded cables and connectors must be used to meet
FCC emission limits. Proper cables are available only from Radlink or it's
authorized dealers.

QUALIFIED SERVICE - All service must be performed by the factory. There
are no user replaceable parts inside the scanner. DO NOT remove the covers
as internal parts may be damaged, the warranty will be voided and it may be
hazardous to your health. The only user replaceable part is the power supply
and then, only after the factory has verified that the current supply is
defective.
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Introduction

The Radlink 16 Laser Scanner is a radiological device, which scans x-rays and
transmits the image to a host computer for review and archiving or forwarding to
other facilities for further evaluation and archiving. The scanner handles film from
2 inches x 2 inches (minimum) to 14 inches x 15 feet (maximum — a reasonable
length is 17 inches). The scanner’s unique design makes it virtually maintenance
free, as there are no mirrors or galvanometers, which are subject to frequent
adjustment. Additionally, the scanning mechanism is shock mounted to allow for
more reliable operation. The scanner is in continuous “calibration mode” except
when scanning, assuring reliable imaging.

Multiple files are supported including TIFF, JPEG, PNG, BMP, Dicom and Raw
formatted images for both reading and writing. Conversion from one file type to
another is automatic.

Multiple images may be sent simultaneously to the PACS hosts and the Dicom
Spooler handles multiple destinations and a Dicom broadcast capability. The
system also supports the opening of Dicom 3.0 files.

The scanner has relatively few controls and connections making the installation
process a quick and efficient procedure. Operating over either the USB or
Ethernet port requires the easy attachment of a supplied cable. The software
completes the remainder of the installation.

An external power supply accepts input voltage from 85 VAC to 264 VAC, 47 Hz
to 440Hz at 3.20 A (rms) for 115 VAC/0.90 A (rms) for 230 VAC Input current,
allowing the scanner to be installed anywhere in the world.

It is recommended that the entire User's Manual be read before proceeding with
the installation.
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Chapter 1: Hardware Installation and Setup

Unpacking the Scanner

Before assembling the scanner, take inventory of the contents of the shipping
carton to verify that all parts are included. If any parts are missing, circle the item
on this page and return a copy of the page to Radlink immediately and the parts
will be replaced.

Mail, fax or phone missing parts request to:

Radlink Inc.

22750 Hawthorne Blvd.
Torrance, CA 90505-3664
Attn: Customer Service

310-373-9763 (fax)
310-373-5673 (phn)

Contents:
Table 1 — Scanner Hardware
Quantity Description Part Number
1 LaserPro16 Scanner 02-00-001
1 Tray — Film Input
1 Tray — Film Output
1 Tray — Film Holder
1 External Power Supply
1 Cable — Power Cord 120 VAC 10A
1 Cable — USB Signal
1 Cable — Ethernet
Table 2 — Scanner Software
Quantity Description Part Number
1 CD - LaserPro16 16 Application &
Drivers
Table 3 — Scanner Miscellaneous
Quantity Description Part Number
1 Manual — User’s
1 Warranty Card
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Host Computer System Requirements

The following lists the minimum requirements to operate the Radlink LaserPro16
and it's associated software:

Table 4 — Host Computer System Requirements

Host Computer

Processor Pentium

Speed 2GHZ or faster

Memory 512mb RAM

Storage 30 Gb hard drive

CD-R

Input/Output ports USB serial
Display

Video card 2 Mb, 1024 x 768 resolution

Monitor 14 inch 1024 x 768 display
Communications

Network 10/100 Base-T Ethernet

Modem 56K Modem

Host Software Requirements
The following lists the minimum requirements to operate the Radlink LaserPro16:

Table 5 — Host Software Requirements

Operating System

Windows 2000 or XP + latest service packs

XP PRO is the recommended OS

Installation
It is important that the enclosed Warranty Card be completed and submitted

before continuing with the installation to protect for scanner repair and to validate
the warranty.
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Assuming the computer is set up, the hardware is unpacked and all parts are
accounted for, the hardware will be assembled first.

Hardware Assembly

Scanner

1. Place the LaserPro16 on a solid surface.

2. Attach the three Film Trays to the scanner as shown in Figure 1.

3. With the scanner backside facing you, place the Power Supply on the
table and plug the output cable connector into the Power Connector (8
pin DIN) on the backside of the scanner (see Figure 2 and 3).

4. Attach the AC power cord female connector to the Power Input connector
of the Power Supply (see Figure 2).

5. Make sure the Power ON/OFF switch (see Figure 3) on the scanner is in
the OFF position.

6. Plug the male connector into a properly grounded 15 Amp A/C outlet. It

is desirable to have the computer and scanner on an isolated circuit to

avoid conducted noise from other devices affecting the quality of
operation.

7. Plug one end of the USB cable into the scanner USB port (see Figure 3).
8. Turn the Power ON/OFF switch on the scanner to ON .

This completes the Hardware assembly.
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Figure 1-1 — LaserPro16 16 Scanner
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Figure 1-2 — Power Supply
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Figure 1-3 - LaserPro16 Scanner Rear View

Radlink Software Installation

All of the required software is contained on the enclosed CD. This includes the
driver, installation and startup program, application and toolkit.

Radlink Installation Procedures

The installation procedures are identical for all supported Microsoft Operating
Systems. Windows 2000, 2003, and XP are the supported operating systems.

Radlink First Time Install Procedures

1. The latest service pack might need to be installed. If they do, the next
step in the installation will request the service pack be installed. The
service packs can be obtained by downloading Microsoft Windows
Updates.

2. Double click the “Double Click to Install Radlink” icon. This installs the
Radlink application. (Simply inserting the Radlink CD will cause the setup
program to be automatically run on most machines).

3. Toinstall the USB driver, plug the scanner into the computer. Windows
will prompt you for the location of the driver. Navigate to the Scanner USB
Driver folder and use the driver in that folder. DO NOT use the Microsoft
default driver (USB in bulk transfer mode). If you inadvertently do so,
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open the control panel, then open system, and then uninstall the incorrect
bulk transfer mode driver.

4. If you are sending images to Radlink, be sure to enter the correct client ID
and Host ID. Your client ID for the Radlink Server is generated by the
Radlink server administrator. He can be contacted at 503 697 9218. If
you are sending images to other PACS servers, contact their
administrators for proper settings.

5. Go to www.eradlink.com and select Software Updates. You should
download the entire release folder to your desktop then double click
“Double_Click_to_Install_Radlink” program in the downloaded folder. This
will start the installation process. There are typically new updates monthly
introducing new features. A brief description of the updates is in the file,
readme.txt.

6. Ensure that the folder “c:\Documents and Settings\All Users\Documents”
has the proper permissions settings. The settings should be for the user
group “Everyone” to have full control. If this action is not taken, The
Radlink application will not have permissions to write to the eRadlink
directory contained therein. If the Radlink does not have permissions,
various errors will occur both during operation, as well as during Key
Activation.

Radlink Incremental Install Procedures
If you have previously installed a Radlink release, the following are the
installation procedures for Radlink Release 4.3:

1. If running Windows XP, install XPSP2 if it is not already installed.

2. Double click the “Double Click to Install Radlink”Icon on the install CD.
This installs the Radlink application. (Simply inserting the Radlink CD will
cause the setup program to be automatically run on most machines).

3. The Radlink Database will need to be synchronized to your existing Image
Archive. Open the Image Acquire Screen and Click “File->Database
Maintenance” menu item then click the “Sync. Database” button.

4. Periodically check www.eradlink.com for software updates. Select
Software Updates. Read the release notes for the latest release. If a
newer version interests you, you should download the entire release folder
to your desktop then double click “Double_Click_to_Install_Radlink”
program in the downloaded folder. This will start the installation process
for the updated release. There are typically new updates monthly
introducing new features.

This completes the Software installation procedure
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Chapter 2:

Software Setup and
Configuration
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Chapter 2: Software Setup and Configuration

Change Scan Settings and Destinations

To change scan settings, Select Settings on the top menu bar, then select
Scanner. The ScannerSettings screen (Figure 2-1) will be displayed.

E Laser Pro 16 Settings g@f@

Scanner Settings

Resolution W | Firmware Up To Date |

Depth |15 v

| Ahlera Up To Date |
Max Rows | 3500

Serial #  |g30270 | LUT Up To Date |

Sleep Timer {20 | |

LUT |LUT1 hd [ Auto Segmentation

Save Cancel

Figure 2-1 — The Scanner Settings Screen

Scanner Settings

Resolution — Number of pixels representing a horizontal line
Options are: 1024, 2048 or 3072

Depth — Indicates the number of gray scale bits
Options are 8, 12, 14, or 15

Max Rows — The maximum length of the scan. As the pixel density is
symmetrical, 2048 would be 14 inches for a Resolution of 2048.

Serial #-  Serial number of the scanner.

Auto Segmentation — The images will now be automatically segmented after the
scan when this feature is enabled

Sleep Timer — Number of minutes before the scanner is placed in
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“sleep mode”. This number entered must be greater than 10

minutes

In the above figure, the scanner is completely up to date with the latest revisions of
the firmware, Altera, and LUT. If one of those items were not up to date, the
corresponding item will change into a button:

E Laser Pro 16 Settings

Scanner Settings

=3

Resolution '-'-'I:I-ilE: w | [ Click To Update Firmware E

Depth |1 5 v |

| Ahlera Up To Date |
Max Rows | 2500 |

Serial # |l]3l]2?l] | | LUT Up To Date |

Sleep Timer |1gu | | ]

LuT ||-'-'T'I Vl [ Auto Segmentation
Save Cancel

A

Figure 2-2 — Updating the Radlink Scanner

In the above figure, the firmware needs to be updated. To update the firmware, click
“Click To Update Firmware” button. A dialog message will appear:
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Changing 5 canned Gating:

Figure 2-3 — Scanner Update Dialog Box

One should click “Yes” to proceed with the operation. During the firmware update
process, the progress bar below the three boxes (or buttons) will show the progress
of the update. When complete, the following message will appear:

Eradiink -10] x|

You Must Turn and Off the Scanner for the changes to <2
take effect 1l \l)

DO THIS BEFORE PROCEEDING.

Figure 2-4 — Scanner Update Directive

At this time, one must turn off the scanner and turn it on again. One should wait for
the scanner to become “Ready” before clicking the “OK” button. The scanner is
“‘Ready” when the LED marked “Ready” becomes lit.
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One should then click “Save” to exit the settings screen.
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Cancel l

Figure 2-5 — Destination Settings

The destination settings are shown above. The destination settings define each
destination’s settings. It also has a field called “State” that instructs the software
whether or not to send a DICOM image from the Radlink Scanner for each
destination. Unchecking the State does not turn off communications to that
destination, however. Again the state check box only controls output from the
Radlink scanner for each destination.

Active Destinations — PACS hosts to receive images

Inactive Destinations — Removes hosts from the Active list
Compression — A variety of compression techniques are available.

Nl

Radlink
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The compression techniques supported are:

noCompression — Save the image uncompressed.

ipeg2000Lossless — Save the image using jpeg2000 wavelet lossless compression.
The number of bits stored will automatically be the number of bits in the image at the
time of the image save. The compression ratio to be expected is typically between 4
and 10 for jpeg2000 lossless compression.

ipeg2000lossy — This compression technique utilizes jpeg2000 wavelet lossy
compression and achieves compression ratios between 10 and 70. The
uncompressed images appear lossless in quality with this compression technique.
JPEG2000 will perform 8, 12, and 16 bit compression.

jpeglossless — This compression technique uses the common JPEG lossless
compression algorithms. The number of bits in the compressed image can be set to
8, 12 or 16 bits. The compressed image typically have a compression ratio of about
5 to one.

jpeglossy — 8 bit Process 1 — This is JPEG 8 bit lossy compression. One can
select a quality factor to control the quality and resulting compression ratio. The
default quality factor is 90. (quality factor is set between 0 and 100). Rather good
compression ratios can be achieved with this compression technique but at the
expense of image quality. The uncompressed image will be 8 bit images of varying
levels of acceptability.

jpeglossy — Process 2 & 4 — This is JPEG 12 bit lossy compression. Like jpeg 8 bit
lossy compression, the quality factor can be set between 0 and 100. All of the
compression algorithms described above are DICOM compliant and will be
compatible with PACS servers supporting the DICOM standard for compression.

All of the above compression algorithms are supported for creating DICOM Part 10
CD’s. However, the default viewer with CD creation is only able to recognize jpeg 8
bit lossy and uncompressed images.

All hosts listed in Active Destinations will be sent the Radlink images as they are
captured from the scanner. The Inactive Destinations will be ignored. If one
selects a destination in either list box, the selection is automatically made in the
Destination Settings combo box. The Destination Settings selection may also be
preformed by using the Host Alias combo box.

Destination Settings

Host Alias — A user chosen name of the PACS host. This name can be
modified by selecting the text in the Host Alias combo box
and retyping a new name. Changing the name will not
impact DICOM communications. Its purpose is for a more
friendly user interface. Note that the Host Alias names are
the names the user sees in the DICOM Spooler Host combo
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box.

IP - Internet IP address. Usually a World Wide Web address, i.e.
www.eradlink.com. IP can also be the physical network node address.
The physical network node address of Radlink is 65.117.85.195.

Port — Port is the logical port of the PACS server. Radlink is currently
using port 107. Other PACS host will have different port
assignments.

Client Title — Client Title is the Client User Name. This field is ignored by most
PACS systems.

Host Title — Host Title is PACS administered. It is case sensitive. Call your
PACS administrator for the Host Title.

Protocol — The normal setting “Radlink” is based on the RSNA 2004 standard
and is much richer in handling various modalities and PACS hosts. The
Radlink protocol setting supports image compression. The older protocol
is based on the RSNA 2000 standard. The protocol setting is
"Mallinckrodt”. This setting was added to accommodate older PACS
systems. This protocol does not support compression and doesn’t support
newer modalities.

State — A host may be placed in either an active or inactive state by
checking this box. Only active destinations will be sent new
scanner images. Changing the state to Inactive will not impact
DICOM images currently in progress or queued for that destination.
Those images will be sent until the queue is depleted.

#Retries — The router will give up and post an error alert if the transmission failed
after that count of retries has been attempted. The default is retry 10
times.

Prompt on Send Failure? — An option to the router to not prompt on a send failure
but rather place the DICOM image in the cancelled queue after a number
of user defined retries. This is important for unattended operation

Destination Settings Action Buttons

New — A new host is created by pushing the New button. A system
generated Host Alias will automatically be generated and can be
easily modified.

Delete — A host can be deleted by pushing Delete after selecting the
destination to be deleted. If there are DICOM transfers in progress or
queued up for that host, they will not be sent. No directories or files are
actually deleted with this operation.

Dicom Ping — One should click the Dicom Ping button to ensure that the Destination
settings, the network settings, and the PACS settings are correct and the PACS
server is accepting associations. If all is well, the following message will be
displayed:
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B Radlink

Successful Dicom Ping | =
If you are expenencing problems. 1
check pour host and chent hitles.

Figure 2-6 — Dicom Ping Success Message

If there are problems, the following message will be displayed:

Bl Radtink H=1E3
Host not found.
Check to make zure the ip and port settings are
cormeck.
Ermror=7

3

Figure 2-7 — Dicom Ping Error Message

The most typical reason for the error message is incorrect IP and/or Port destination
settings. The Dicom Ping button is also present in the Radlink Router destination
settings.

Router Settings

The purpose of the Radlink Router Scheduler is to postpone Dicom uploads to after
business hours.
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E Router, Settings

Listener Port

By checkingthe Schedule

Router checkbox, you are

turning offthe Router except

between thetimes selected.
[ ] Schedule Router ?

i

Figure 2-8 — Radlink Router Scheduler

When the checkbox is checked, the router will cease to send images except
between the times selected.
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E Router, Settings E@@

Listener Port | 3000

By checkingthe Schedule

Router checkbox, you are

turning offthe Router except

between thetimes selected.
Schedule Router ?

Router Schedule

Start Time: | £.45:.00 PM 3 %

End Time: | 44:45:00 PM =

Figure 2-9 — Scheduler Settings

In the above example, the router will only transfer images to the PACS hosts
between 5:45 PM and 11:45 PM.

Listener Port —. The Listener Port is a port on the client machine that the
Radlink Router listens to for “Send Status” button clicks. The Listener Port
typically should not be changed. If the client already utilizes port 3000 in
some other client application, this port setting should be changed to another
available client port. If there is a port conflict, the router screen will not
appear when the “Send Status” button is clicked. This port is also utilized by
Image Acquire for sending images to the router.
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_lnix

Raw File Format

Rows ([N

Columns |2|:|4g

Depth |16

Save | [,\\(.) Y

Figure 2-10 — Raw Format Settings

The Raw File Format settings define the settings for reading a file with no header

information. The Raw File Format defines the rows, columns, and depth of the raw
bitmap image.

Raw Format
Rows — Number of rows in a Bit Map file.
Columns — Number of Columns in a Bit Map file.
Depth - Indicates the number of gray scale bits (8, 12 or 15).

_lolx

Firewall Information

Address: ||

Port: I

i~ Bypass Proxy Server
for local addreszes

Save |

|ra USER MANUAL Page 22

Radlink



Figure 2-11 — Fire Wall Settings

The firewall information contains proxy server IP information that is necessary for
routing images through the Firewall, if one is present. These settings are also
present in your Internet Explorer browser and can be found by clicking
Tools—>Options and clicking the connections notebook tab:

2=

Eenerall Securit_l,ll F'rivan:_l,ll Content  Connections | F'n:ugramsl .&dvancedl

W Tosetup an lntemet connection, click Setup...
Setup.
— Dial-up and “irtual Frivate MNetwaork, settings
i EarthLink glenncrosse@earthlink. net [0 efault) Add...
“H PrivateMet
“4i Virtual Private Connection - Mary Remove
Chooze Settings if you need to configure a pro<y Settings. ..
zerver for a connection,

" Mever dial a connection
% Dial whenewver a network. connection is not present

" always dial my default connection

Current default;  EarthLink Set [Mefault

— Lozal Area Metwork [LAMN] zettings

LAM Settings do not apply to dial-up connections. LAM Settings. ..
Choose Settings above far dial-up zettingz.

I-

3

k. | Cancel Amply

Figure 2-12 — Internet Options Settings

To locate the firewall IP settings, click “LAN Settings...”.
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Local Area Network {LAN) Settings

2| x|

— Automatic configuration

W automatically detect settings

[ Use automatic configuration scripk

futormatic configuration may override manual setkings, To ensure the
use of manual settings, disable automatic configuration,

fddress I

—Proxy server

dial-up ar YPN connections),

¥ Bvpass proxy server faor local addresses

r Use a prowy server for yaour LAMN (These settings will nok apply to

address: I Park; I advanced,,,

|3

4

Cancel

Figure 2-13 — LAN Settings

Simply copy the Proxy server settings into the Radlink Fire Wall Settings.
If no settings are present and you have a Firewall, contact your LAN administrator

for the above settings.

It should be noted that the protocols being utilized by the Radlink system are TCPIP
and SOAP. The SOAP protocol uses an extended HTML packet header for
communications. Some firewalls do not allow HTML extensions. If that is the case,
request your LAN administrator to configure the firewall to allow extended HTML

packet headers.
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_lnix

Cine Image Delay Im

Repeat Count |4

Save | %

Figure 2-14 — Cine Settings

4

“Cine Image Delay” is the number of milliseconds each image will be displayed in Cine

mode. 100 is a typical number for this setting. “Repeat Count” is the number times the
images will be displayed in a loop fashion.

Elnfurmatiun Display Settings - |I:I|5|

— Display Selections
¥ Hame
¥ Date Of Birth
¥ Patient ID
v Sex
v Studyrseriesimage Humber
¥ Study Date

v Zoom

v window Level Display [%

{* Show Selections { Hide Selections

Save |
A

Figure 2-15- Information Display Settings
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The study information is displayed in the upper left side of the image display area
when the “Show Selections” radio button is selected. The items in the study
information is selectable by clicking the check boxes as shown above.

Required Fields

The fields on the “Patient Information Screen” can be set as “Required Fields” by the
user of Image Acquire. The settings for required fields can be found by clicking the
Settings>Required Fields menu item on the Image Acquire main screen:

Figure 2-16 — Required Fields Menu Item

The following settings screen then appears:
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K Required Field Settings

Required Patient Info Fields

Patient Hame [ ] History

|:| Accession Humber |:| Hospital
Patient ID [ ] Priority

|:| Study Description |:| Status

|:| Reaszon For Exam |:| Exam ID

[ ] Referring [ ] station Hame
[ ] Birthdate [ ] Study Date

Figure 2-15- Required Patient Info Fields
The image acquire application will check for all fields checked above on the patient
information screen to ensure that they have been completed. Previously only the
“‘Patient Name” and “Patient ID” were required fields.
Dicom File Settings
Radlink performs image compression both in saving studies as well as sending to

remote destinations. The following figure displays the compression settings associated
with saving studies:
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E Dicom File Settings

Compression

noCompressio

noComprezsion

ipeg2000Lossless

ipeg2000Lossy

ipglossless- First Order Prediction Process 14
ipglossy - 8 it Process 1

jpolossy - Process 2 & 4

CD Settings
Full Path H ame of Yiewer to Include:

Save

Figure 2-16 — Dicom Save Study Compression Options

The compression techniques supported are:

noCompression — Save the image uncompressed.

ipeg2000Lossless — Save the image using jpeg2000 wavelet lossless compression.
The number of bits stored will automatically be the number of bits in the image at the
time of the image save. The compression ratio to be expected is typically between 4
and 10 for jpeg2000 lossless compression.

ipeg2000lossy — This compression technique utilizes jpeg2000 wavelet lossy
compression and achieves compression ratios between 10 and 70. The uncompressed
images appear lossless in quality with this compression technique. JPEG2000 will
perform 8, 12, and 16 bit compression.

jpeglossless — This compression technique uses the common JPEG lossless
compression algorithms. The number of bits in the compressed image can be set to 8,
12 or 16 bits. The compressed image typically have a compression ratio of about 5 to
one.

jpeglossy — 8 bit Process 1 — This is JPEG 8 bit lossy compression. One can select a
quality factor to control the quality and resulting compression ratio. The default quality
factor is 90. (quality factor is set between 0 and 100). Rather good compression ratios
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can be achieved with this compression technique but at the expense of image quality.
The uncompressed image will be 8 bit images of varying levels of acceptability.

jpeglossy — Process 2 & 4 — This is JPEG 12 bit lossy compression. Like jpeg 8 bit
lossy compression, the quality factor can be set between 0 and 100. All of the
compression algorithms described above are DICOM compliant and will be compatible
with PACS servers supporting the DICOM standard for compression.

All of the above compression algorithms are supported for creating DICOM Part 10
CD’s. However, the default viewer with CD creation is only able to recognize jpeg 8 bit

lossy and uncompressed images.

Overlay Settings
Color and Font settings are provided for Calipers, Annotation, and Measurements.

One changes the color by selecting the Menu Item Settings—->Overlays:

e |4 .F

1 EIALA T T e
G E

Figure 2-17 — Overlay Settings Menu

The following settings screen then appears:
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K Overlay, Settings E@@

Color Font

Annotation Settings _ | Edit |
Measurement Settings [_][ Edit ]

Caliper Settings _]
R

Figure 2-18 — Overlay Settings

On the above screen there are Color and Font settings buttons for Annotation and
Measurements and Color settings for the Calipers. When the “Edit” button is clicked in
the Color column, the following screen appears:

B aszic colors:

M [N
Hf [TET NN
HENNEENNEN
HENEEEENEN
EEEEEENEN

Custam calors:

HEEEENENB
HEEEEENBE

[ Define Cugtom Colars »» ]I

[ OF. H Cancel ]

Figure 2-19 - Color Picker

Choose the desired color by clicking a color then click OK. The New Color button
background color will then display the chosen color. One changes the fonts by clicking
the button “Edit button in the Font column. The following screen then appears:
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ladimi S crip Bold 26 | ok |
wﬁm # || | Regular 22 ”
Wrinda — | | Italie 24 b

() wehdings

'} wide Latin Bald ltalic 28

() winagdings 36

() “wingdings 2 — 8/

(} wWingdings 3 b 72~

Effects Sample

[ ] Strikeout

] Underline ‘7%;" gj%;

Script;
% | “Wiestern w |

Figure 2-20 — Font Picker

The font picker displays all of the fonts, and font sizes in the system. Choose the
desired font, font style, size, and font effects then click OK.

For this example the Annotation and measurements color and font have been changed
to light blue and font of Vladimir Script::

E Overlay, Settings : E E|

Color Font

Annotation Settings Edit | E ,. |
Measurement Settings _ | g : |
Caliper Settings _]

Figure 2-21 — Modified Overlay Settings

|ra USER MANUAL Page 31

Radlink




One should then save the settings by clicking the save button.

Radlink settings can be protected with a password. To enable password protection for
Radlink settings, simply change the password:

Figure 2-22 — Changing the Settings Password

The following screen appears after selecting the Change Password menu item:

New Password ||

Retype Password

oK [y

Figure 2-23 — Change Password Dialog

After the password has been set, one must enter the password to change Radlink
settings by logging into Radlink via the Login menu item. If the password is not entered
upon Radlink startup, the “Settings” menu item will be disabled.
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Chapter 3: Operating Instructions

Startup

To start the Radlink software suite, double click the Radlink Image Acquire Icon
on the desktop or click Start->Programs—->Startup—->Radlink Image Acquire
from the start button. The Main screen will appear (Figure 4):

Release Level

To determine which release of Radlink software you are working with, click on
Help on the top toolbar then click on About Radlink. The release level will be
displayed. This is a necessary piece of information if you place an inquiry with
Radlink customer service.

User’s Manual

The content of this user’'s manual is included in the application. Click on Help on
the top toolbar then click on User’s Manual. This user’s manual will then be
displayed in an internet browser. No connection to the internet is required, as the
manual is installed with the Radlink application.

f
I

n o
£l
.
B
i
>

iﬂiiff"'ln

I
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18] 8 J68 |13 e i fre =
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Figure 3-1 — The Radlink Main Screen
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The menus are designed to enable the main Radlink screen to be operated without
buttons. The menu items are:

E\Ean
Patient Infa.
Send Study
Send Status
(T
teel Ly Reverse Order
¥ Segmentation  #
Flip Image 3
Rokate Image  »
Delete 3
Scals 4
Create Series
- G0 To 2
v Show Buttons CINE
v Show Patient Info
v Show Caliper Annotate
Shaow Hiskogram Measure
2 A Ot MHegative Studies Completed
pletes Change Password m
. Dravs Test Image Zoom 4 Patient Report % ::iﬁwg ey
File Settings View Tools Reports Twain Login Help

The Main Screen is composed of four major sections:

1. “Sending” Information (Destination and Status)

2. X-ray image and series of X-ray image list.

3. Scanner Status on the Application status bar displaying real time status

K]

Radlink

of the Radlink Scanner.

Action Buttons.

The four Rotate and Flip buttons allow for different views of the displayed
X-ray.

The Scan button activates the scanner causing the x-ray film in the
scanner Film Input Tray to be scanned. The image is displayed line by line
as it is scanned.

The Delete button will delete the selected image in the image series list.
The Clear button will delete all images on the screen.

The Send button causes the x-ray image and patient information to be
transmitted in DICOM file type to the listed destinations. While the images

are being transferred to the listed destinations, the destinations will also
appear on the list to the right.
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When all DICOM transfers are complete, the list to the right side (Sending)
will be blank:

The W and L sliders are for setting the Window and Level for the selected
image. After a scan completes, the window and level settings are
automatically computed and set. These settings can be overridden by
moving the sliders. These settings are stored in the DICOM file header
and are passed on to the PACS system. Most viewers will then open the
DICOM image with these settings. The histogram below the window level
sliders graphically displays the pixel distribution over the possible pixel
values. For a 16-bit image, the maximum pixel value is 65536. For an 8-
bit image, the maximum pixel value is 256.

Window/Level can also be set by using the mouse with the right button
depressed and dragging the mouse over the image. Dragging the mouse
horizontally will change the window setting. Dragging the mouse vertically
will change the level. The sliders will move accordingly.

The Negative check box is for negating images. The following is what the
images look like after checking that check box:

RUFHERAIGED % (T

i§|s.= :*~|

|5 5 |tejud

| i

Figure 3-2 — Negative Check Box Effects

To the Right is a button called “Reverse Order”. The following figure shows the
Reverse Order button:

Nl

Radlink
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Figure 3-3 — The Reverse Order Button

When the button is clicked, the order of the image list is reversed. This is shown in
the following figure:
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Figure 3-4 — The Reversed Image List

The Button to the right is a window level presets button. This button gives one three
methods for setting the window level of an image being scanned. The first method is
to use the “Automatic” window level to let the software determine the proper window
level setting. This is the default setting and is the methodology used before this
release. The second method is to not apply window level settings after the scan.
This is the “None” setting. The third method is to set the window level based on user
defined presets. One picks the method by clicking the button to the left as shown

below:
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Figure 3-5 — Window Level Presets Button

When the button is clicked, the following menu is displayed:

Figure 3-6 — Window Level Presets Menu
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The menu items are split into three groups: Specific window level settings based
upon user preferences, machine directives for window level settings i.e. Automatic or
None, and Settings. If any choices are selected in the first two groups the selected
image will be automatically window leveled to the choice selected. Please note that
subsequent film scans will have this choice applied for the window level setting. The
choice will be displayed as the text of the window level button as shown below for a
choice of “None”:

by [T [igLe [on (g st § [relre v G

I

Figure 3-7: The effect of selecting None from the Presets Button

The window level presets are all defaulted to window =0 and level =0 for all of the
window level presets that are user definable (group 1 menu items). In order to set or
change these settings, on should select the menu item, “Settings”. When that is
done, the following screen appears:
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ﬂ[ustumize Window-Level Presets -0 x|

Text Window Level

IBune Il] ||] Get Current |

TEXT | Window| Level
Abdomen 0 0
N Bone o o
_R"?_Cerehrun 0 0
Liver 0 0
Lung 0 0
Media=tinum 0 0
Pelvis 0 0
Posterior fossa 0 0

Save | Cancel | Get Default |

Figure 3-8 - Window Level Settings

4

One should select_item to be edited by clicking on the desired line. In this example
we chose Bone. The selected line then appears in the editable boxes at the top of
the screen. The name of the item can be changed by typing into the input box called
Text, and likewise the window and level can be changed by changing the input
boxes for those two item respectively. One should then click “Save” to save the
settings. When Save is clicked, the settings are saved and the settings screen
disappears. To apply those settings, one should click the presets button again and
select the desired preset. The following screen shows the screen as the preset
bone is applied:
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Figure 3-9: Applying a User Defined Window Level Preset

To simplify the task of choosing the numeric value for a user defined window level
preset, one can simply window level an image and save it as a preset. To do this
first select an image. Then window level it using the right button mouse and
dragging it across the image until the desired window level setting is achieved.
Then one should then click the presets button and click “Settings”. Then the
desired preset line item should be chosen. Lastly to replicate the window level
setting to that line item one should then click the “Get Current” button. One
should then click save to save the settings and return to the main screen. To
apply those settings to other images or images to be subsequently scanned, one
should click the presets button and select the desired preset menu item.

The bottom icon buttons have pop up help to assist in identifying the functionality:
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Figure 3-10 — Pop Up Help

In the above figure, the mouse is held over the segment In this example the
message “Segment into Images” pops up.

Scan
To perform an x-ray scan:

Place the x-ray in the film input tray, top up, face out (only one x-ray at a time
should be in the input tray).

Click on the Scan button on the main screen or press the Scan button on the
scanner. The image will then be placed in the image series list and will be
selected.

After the Scan is complete, fill in the patient information section.

Send

To send the series of files to other PACS hosts, click on the Send button. The
destinations under Send To will receive the file.
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Figure 3-11 —File Menu Items

The five file related menu items are Open Archive, Open Study, Save, Import, and
Export. Open Study, Open Archive, and Save are used for opening and saving
DICOM images. Import and Export are for importing and exporting foreign file types.
The following screen shots explain how these menu items operate.
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Figure 3-12 — Open Study

To open the exam for patient named “seriestest”, would select the exam for
“seriestest” and click Open Files
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Figure 3-13 — Viewing an Exam

Directory navigation is accomplished by clicking the Change Directory button.

[=] =# Local Disk (iC:) ;I

) 4-12-2003

) 04 17 03 J
[ Accuiiew
) appdancerz-44

Iy derndb

) CI-3000

) dicom pascal
) Docs

) Docurnents and Settings

) DRIYERS j

Make Mew Faolder | Ik I Cancel |

A
- Figure 3-14 - Directory Navigation Screen

Ira USER MANUAL Page 46

Radlink




One navigates to the desired directory with the standard Windows File Open Dialog
shown in Figure 3-7.

Files can be sent directly from the archive or any other selected directory. To do this
simply select the menu item File->Open Archive or File->Open Study from the
Radlink main screen or select the File>View Archive from the Radlink Router:

E Radlink Opas Hoem Files

Directary:  CiDecuments and Setlingsiill UserstiDocumenisieRadinklimage Archive

L
[ Pt i1
| open Sclecina sy | | Cancal | | [ | | Send |
Ii
| Fobonk hleare: iipaindy | [vssoription Faberik i0 Elrihdale Rerberring 1. T [usie o
1 = 1 Unrand  [FATIGIOS
AL BEERTEuROaRs L] e aupn EEATEATEE 190300 Urwssd [ty
SLEETVTES PR, "] Fand'rodira EEITEITEE 13480302 EMZEL Unrand  [FATIGIOS
AL BEERTEuROaRs L] 0 STl ik EEATEATEE 190300 Urwssd [ty

SNDPEADEFLIZARETH cr SED PR DDDEA [FI 53 SCHECTER LUrrasd [ lielrr i

BLLETEIRHFHN L] LopineyoRing: STERCEEET 190N FLATT Urwssd [ty
BONGESCOREEN "] ergbaaTary 14 m0eT 19360312 BAHER FAC Urasd  [FATIGIOS
CEMPEEL L P WD [4) T ERTRERKET Urwsad  (RERED0E
CAPTVLL A MEE or Abderan® DL PHADE SERCEDGMD  17I0MA HERT Urasd  [FATIGIOS
R [4) AF Paird RET (EIE AR Lirwesad [T irte)
DR HAR IR or LTFLARE PAM L] WS Urasd  [FATIGIOS
LETORT:, ALEGRE W LEFTHF 2l 193 IS WCHRLD Urwsad  (RIRED0E
FPEESE, A or HEAD WA 45477 05EE PAETTIA Urasd  [FATIGIOS
CATHETTRICSEFH L [T ] TR 1 A UrdaSsaHal Uwasd  (rdREO0E
HOPPPATACLL "] rack_paf-ArosrToine SADE[ETIE 19430208 -1 Urasd  [FATIGIOS
ARy R e yimhi ik RETAH Lirwesad [T irte)
papcazinay baxt 5C 1 Urasd  [FATIGIOS
LARGILERDS, =3 TiEdis FER Urwssd  (RELED0E
LASKTERTSELL or Abderan® DAL PHADE iSRS 13400M9 o Urasd  [FATIGIOS
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Figure 3-15- View Archive Screen
A filter has been added to assist in the rapid search of the desired study. Simply type

the first character or two of the patient name and/or the first character of the patient id to
narrow the scope of the studies displayed.

ra USER MANUAL Page 47

Radlink



Directary:  CaDecuments and Settingsiall UsersiDocumentsieradinklmage frchive

(FL L
12naEn
(FL L
12naEn
A5
TR
(LR 3]

Figure 3-16 — Using the Study Filter

In the above example, the character “c” was typed into the patient name filter to narrow

down the search to all patients whose name begins with “c”.
After the study or studies have been located, select them and click the “Send” button to

send them on to other PACS systems. The following dialog will be presented:

E Choose Destinations

Send To

[] efilm
loopback

K

Figure 3-17 — Destination Selection
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All of the destinations previously defined will be presented with check boxes. Check the
destinations you wish to send the studies and click “Send”. The studies are then
spooled to be sent to those destinations.

To open and view DICOM images that have been previously sent to PACS hosts,
one should select the menu item File>Open Archive. This will bring up a open
Study dialog as in Figure 3-4 above, pointed to the image Archive.

To save an Exam, click the File > Save menu item. The following dialog box will
appear:

[=] = Local Disk (T ;I

| #4-12-2003

) 04_12_03 J
I Accuiew
|Z) appdancerz-44

|2 demdb

IC3) DI-3000
() Dicom Download Direckary

|2 dicom pascal

£ Docs
| Documents and Settings %
|=) DRIVERS |
Make Mew Folder | (0] 4 | Cancel |

£
Figure 3-18 — Selecting a Save Directory

One navigates to the desired directory with the standard Windows File Open Dialog
shown in Figure 3-8. To create a new directory for downloading, click “Make New
Folder”
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[l L) Dicom Download Direckory
3 30bin Smikh's Exam |
I3 dicomn pascal %
I Docs

| Documents and Settings lI

Make Mew Falder | Ik I Cancel |

Ve
Figure 3-19 - Creating and renaming a folder.

After creating the folder one should rename it and then navigate to it by clicking on it.

= == Local Disk () ;I
I 4-12-2003
04 12 03 J
I3 Accuview
I3 appdancerz-a4
I3 demdb
| DI-3000
[El [25) Dicom Download Directory
& 1ohn Smith's Exam
I dicom pascal

I DoCs
I3 Documents and Settings LI
rMake Mew Folder | K | Cancel |

Vi
Figure 3-20 - Navigating to the newly created save directory

After the folder is created and selected for save, as shown above, Click the OK
button.
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To import and image into a study, click File=>Import.

Navigate to the desired directory as shown in the above examples. Choose the file type
you wish to import and select the file. If the file type is unknown, choose “all files” in the
file type combo box.

Lock ir I by Pictures j - 5 E-
Sample
Wy Documents
tdw Computer
g
&= File name: ISampIe - Open I
by Metvaork P
Files af type: Al Files [*7) Cancel |
E

Figure 3-21 — Importing Images
In the above example, a JPG image called Sample has been selected for Import. Click
Open to import the image.
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Figure 3-22 - An Imported Image.
The image, as shown above, is then added to the exam. The image could be any
standard JPG, PNG, TIF, etc. type image. The image could also be a scanned
document that is to be inserted into the study for referring doctor exam documentation.
When the exam is sent, via the Send button, the entire study, including the newly added
image is sent as a package.

One can also export any image in the study. First select the image to be exported by

clicking on the thumbnail for the desired image. Then click File>Export. The following
dialog will appear:
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Bl Radlink Save File

File Type Compression
) JPEG2000 Compression Ratio
© JPEG () JPEG Lossless
S ol auayFator 15|
) RAW ' ~ ]
IPHG
[% [ Save ] [ Cancel ]

Figure 3-23 — Exporting Images File Type Selection

One should select the file type and the compression technique desired. If the image is
JPG, Compression Ratio is enabled for the JPG Lossy Compression technique. After
selecting the options, click Save.

The following dialog box will appear:

Save in: I My Pictures x| = 5 ER-
[,
Sample i
|C:'|,D-:u:ument5 and Settingsigcrossel My Docurnentst My Pic
File name: || j Save
Save as type: I.JF'G Files [*.jpa) j Cancel |
g

Figure 3-24 — Image Save Dialog
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Choose any file name desired and click save. Note that the File Type is predetermined
and cannot be changed. This file type was chosen in the previous step as shown in
Figure 3-22.
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A historical report of all studies read is produced by clicking on the menu item
“‘Reports—> Studies Completed” on the Radlink Image Acquire screen:
[ L

S L
T
T | -

Figure 3-25 — Reports Completed Menu Item

When this menu item is clicked, a report of all studies read is displayed and can be
printed”

Ira USER MANUAL Page 55

Radlink



Feadarting R Dl
L 1 i |

R LU lal | -I=|-|=|

Figure 3-26 — Studies Completed Report

While the report opens, the following dialog appears:

1\Program FilesieRadlinkiReadlog. xls

This warkbook contains queries to external data that refresh automatically.

Queries are used ko import external data inko Excel, but harmful gueries can be used to access
confidggtial infarmation or write information back to a database.

I wou trost the source of this workbook, wou can enable automatic guery refresh, IF vou disable
aukomatic query refresh, wou can later refresh queries manually, if wou are satisfied that the queries are
safe,

Enable automatic refresh I Disable sutomatic refresh I

Figure 3-27 — Query Refresh Dialog

One should click the button “Enable Automatic Refresh”. This will ensure that the
report has the current information.

Disk Management Screen
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The Archive Maintenance screen is activated by selecting the menu item
File>Database Maintenance.

E Radlink Archive Maintenance g@@

Purge files we | Days
older than: ﬂ

( |

Archive | m\Nocyments and Settingshall
Directory S E
Sync. Database

Backup
Database

Delete+Restore
Database

Purge Old Files

Exit

Figure 3-28 — Radlink Archive Maintenance

The “Purge Files Older Than:” drop down list is the number of days that
images will be retained in the Archive before being automatically deleted.
This retention policy also applies to log file entries. Thus all logging entries
older than that period will be removed as well.

The “Sync. Database” button should be used to synchronize the database
tables based upon the current image directory contents. This action can be
lengthy depending upon the number of images in the archive. The progress
bar on the screen with a “number of files” counter displays the current status
of the database synchronizing process.

The “Archive Directory” location can be changed by clicking the Folder Icon
to the right. Changing the Archive location will automatically synchronize the

database based on the new archive directory contents. Please note that this

capability previously was located on the destination settings screen.

The “Backup Database” button will backup the SQL database. It is useful to
periodically backup the database as most user settings are contained in the
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database. The backed up database is called “Backup” and is located in the
Radlink installation directory (Typically c:\program files\eradlink\backup”.

The “Delete + Restore Database” button is used to restore the database
from a previous backup. The action deletes the current Radlink Database
then restores it with the last backup. The backup file is called “backup” and is
located in the Radlink installation directory. The database is automatically
synchronized upon the completion of the database restore process.

The “Purge Old Files” button purges images and log file entries older than
the retention period. This action is automatically performed upon Radlink
application startup. It is also automatically performed once per day in
unattended router operation.

Image Printing

Figure 3-29 — Radlink Print Menu Items
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The print menu items are arranged in two groups. The first group is for postscript
printing. Using the postscript requires that the printer be correctly configured. One
does this by selecting Print Setup which will produce the following printer setup

dialog:
pent 2| |

— Printer
t ame: YWR51-SERVERNLexmark Optra B Series Properties. .. |
Status: Feady
Type: Lexmark. Optra B Series
Where:  LPTT:
Carnment: I™ Prirt ta file

— Print range Copies
Lol Mumber of copies: m
" Fages fram:l— ta:l—
£ Selection |ﬂ| |ﬂ| & Golere

[

] I Cancel |

Figure 3-30 — Printer Setup

One should then select the printer using the combo box as shown above. To
change the printer properties click Properties. The Properties dialog will permit you
to change the print layout to “Landscape” or “Portrait” and also change other printer
settings such as paper size, printer paper source, etc.

One should then set the image layout. To do this select Print Layout:

=

Rows F 5:
Columns F 3

114

[~ 4
Figure 3-31 — Print Layout

The print layout describes the image placement. In this example there are to be 4
images per sheet of paper arranged in 2 rows and two columns.

Nl
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One should then preview the images before printing by selecting Print Preview. The
images will then appear just as they would if actually printed. One can now change
the printer settings if necessary. One then actually prints the images by selecting

the Print menu i

tem.

One can send images to a DICOM printer by selecting the DICOM Print menu item.

The following screen then appears:
ﬂ Dicom Print
Layourt Job Printer
Format: Priority: Medium: Copie
STANDARD'.1 3 HIGH L BLUE FILM 1 % Printer w
Cropping
HONE w
Settings Densities
Film Orientation: Film Film Destination: Min Borde
PORTRAIT | 1THHXITIH % |  PROCESSOR 1 £ BLACK w
Magnification Smoothing Trim: Max: Empty: Polarity
HOHE + | | MEDIUM | | YES - 300 3 | |BLACK | HORMAL -
Hetwork Settings
P Port Client Title AE Title =
127.0.01 108 ERADLINK DICOM_PRINTER Status
SovoSotings (o ]

Figure 3-32 - DICOM Print Dialog

The figure above shows the settings that can be made for the DICOM Printer. One

selects the DICOM printer by selecting the printer from the printer Combo Box. New
printers can be created by clicking the button “New”. A printer can be deleted by first
selecting the printer to be deleted then clicking the button “Delete”.

The Printer IP, Port and AE Title should now be entered. Note that the AE Title is
typically case sensitive. After the Network settings are entered, one should test the
connectivity to the printer by clicking the Printer Status button:

Nl
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E Printer Status

Status: HORMAL

Status Info Code

Hame: Emulator

Manufacturer: AGFA

Model Hame: ADVT

Serial Humber: 123456 L})
Software Version: ADVTDLL2.6

Date of Calibration: 19990915

Time of Calibration: 121500

Figure 3-33 — Printer Status

The printer should return with the NORMAL status. Click OK to return to the DICOM
Print settings screen.

One should then enter the proper settings for all of the fields on the DICOM Print Dialog
window. After entering the settings, one should click Save Settings to save the settings
for that printer. After the settings are entered and saved, click Print to print the images.
When the printing is complete, click Exit to return to the Radlink main window.

The following are the permissible settings for the DICOM Perinter:

Format: This field specifies the layout of the images on the film. The numbers at the
end are the number of rows and columns. The following are the permissible values:

STANDARD\1,1

STANDARD\1,2

STANDARD\2,2

STANDARD\2,3

STANDARD\2,4

STANDARD\3,3

STANDARD\3,4
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STANDARD\3,5

STANDARDW4,4

STANDARDW4,5

STANDARDW4,6

STANDARD\5,6

STANDARD\S,7
Cropping: These are Codonics “True Size” settings. Permissible values are:

CROP

DECIMATE

FAIL

NONE
The value NONE will make the Radlink software not to send the crop decimate DICOM
tag. This choice was added to ensure compatibility with other printer
manufacturers. The other values cause a new DICOM tag to be added. The tag is
(2020,0040) CS. This instructs the Codonics Horizon printer to either crop if the image
is bigger than the printable film size, decimate the image to fit the printable film size, or
fail if the image is bigger than the printable film size respectively. This element gives
“True Size” capability for images that are larger than the film size being printed to.

Priority: This is the print job priority. Permissible values are:
HIGH
LOW
MED
Medium: This is the print medium. Permissible values are:
BLUE FILM
CLEAR FILM
BWGen
PAPER
Copies: This is the number of copies to be printed. Permissible values are from 1 to
100.
Film Orientation: The permissible values are:
LANDSCAPE
PORTRAIT
Film Size: The size of the film. Permissible values are:
4INX6IN
8INX10IN
85INX11IN
8.5INX11IN
10INX14IN
11INX14IN
14INX14IN
14INX17IN
24CMX24CM
24CMX30CM
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A4
Film Destination: This is typically the bin that the film will be deposited into.
Permissible values are:
BIN_1
BIN_2
BIN_3
BIN_4
BIN_5
BIN_6
BIN_7
BIN_8
BIN_9
PROCESSOR
MAGAZINE
Magnification Type: Permissible values are:
REPLICATE
BILINEAR
CUBIC
BICUBIC
MITCHELL
LANCZOS
SHARP1
SHARP2
SHARP3
NONE
Smoothing: Permissible values are:
MEDIUM
SHARP
SMOOTH
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Trim: This signifies whether or not to do cropping. Permissible values are:
NO
YES
Min Density: Permissible values are from 1 to 399.
Max Density: Permissible values are from 1 to 399.
Empty Density: Permissible values are from 1 to 399.
Border: This is the border color. Permissible values are:
BLACK
WHITE
Polarity: This is whether the image is to be printed as a negative or normally.
Permissible values are:
NORMAL
REVERSE
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The procedure for image acquisition should begin with filling in the study information.

One should first click the button (or menu item) “Patient Info. The following screen
will then appear:

B patient Information g]

Patient Information
Hame |Glenn Crosse

Accesszion # |GEG

Patient D 1
Birthdate |12:311983 w
Sex (M v
Study Date |12/ 9.2004 w

Study Desc | A Study Description

Reason For
Exam

Referring Dr. Jim Bob

A Demo

History |A cronic History of Demos
Hospital |5t. Glenn's Memorial

Station Hame | AE_LAPTOP w

Modality |SC w %
Priority | High w
Status ||

ExamID |1

Auto Clear?

Search

‘Sa\re-Exﬂ

‘ Save ‘

Figure 3-34 — Patient Information

The auto clear check box if checked will automatically clear the patient information
upon a save study or send study event. If not checked, the information will persist
and not clear from study to study.

The priority combo box sets the study priority that dictates its priority in the router
send queue. This priority information is also passed along to PACS which will affect
the priority of the study at that host.

Use the Search button to perform a “Modality Worklist” patient search, a “Remote
PACS” patient search, or a “Local Database” patient search.
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After the Patient Study Information is entered, one then presses exit and performs
image scans by pressing the scan button. When the images are all scanned, one
should then press the Scan button which will send the images to the PACS system.

The Patient Search screen will allow one to automatically fill in the “Patient

Information” by using patient information in the PACS database. The following
describes how to use this feature.

First click on the Patient Search button from the patient info screen. The following
screen appears:

E Radlink Patient Search EI[E| E|
PACS Host )
Patient Hame
Patient 1D
Sex b

Figure 3-35 — Search Screen

One selects a PACS Host in the PACS Host list shown above, enters the

appropriate search criteria for Patient Name, ID, and Sex then clicks the Query
button.

In the above example there is no PACS Host listed. One must be created before the
search can be accomplished. To add a PACS Host, click the Settings button.

|ra USER MANUAL Page 66

Radlink



E Radlink Settings Q@E|

Alias HostAlias WinFX v
IP
65.117.85.199
Port
104
Client Title
eRadlink
AE Title
AE_WIHFX

Search Type PACS Patient Sea

[ Hew ] [ Delete ]

Figure 3-36 — Search Settings Screen

The information below must be filled out. See your PACS administrator for the
appropriate settings.

Host Alias — A user chosen name of the PACS host. This name can be
modified by selecting the text in the Host Alias combo box
and retyping a new name. Changing the name will not
impact Dicom communications. lIts purpose is for a friendlier user
interface.
IP - Internet IP address. Usually a World Wide Web address, i.e.
www.eradlink.com. IP can also be the physical network node address.
The physical network node address of Radlink is 65.117.85.195.
Port — Port is the logical port of the PACS server.
Client Title — Client Title is the Client User Name. This User Name is
typically administered by the PACS host.
AE Title — AE (Host) Title is PACS administered as well.
Search Type — This can be a Modality Worklist search or a PACS Patient search
or a Local Patient Search. If the search type is Modality Worklist, the
accession number will also be returned.
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ﬂﬂadlink Settings ;lglil

Alias HoztAlas I PACS Host j
IP
PACS Host [127.0.0.1
Port
[108
Chent Title
|eRadiink
AE Title
|Pacs

Search Type | PACS Patient Seal j

Hew | Delete |

Save | Cancel |

Figure 3-37 — Example Search Settings

4

In the above example, the Host alias was changed to PACS Host. The IP of the
PACS host is 127.0.0.1. The port for this PACS host is 108. The AE Title for the
PACS server is PACS. The Client title for the Radlink client is Radlink in this
example. Once the information has been entered, click on the Save button.

B radiink Patient search -0 x|

PACS Host

Patient Mame |

PatientID |

Sex I j

cuory_| oo _|

Figure 3-38 — Patient Search Screen

[

Select the appropriate PACS Host from the PACS Host list. This will be the host that

will be searched for patient information. In the above example, there is only one
PACS Host and it is selected. Next enter search criteria. For example if one typed
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G in the Patient Name input box, all patients whose name begins with “G” will be
returned. Then click on the Query button. In this example we will not enter any
search criteria. All patients in the PACS database will be returned as shown in the
following figure:

=il

Patient ID | Patient Hame | Birthdate |sex+

» 0-0 AHDERSOH,KHALIAH 19958.08.22 F
1450-03 Anderson,Klahiah 19958.08.22 F
333 ann 2003.07.25 O
3012-03 Atkins, Calvion 2001.09.19 M
67890 barnesjack 2003.08.28 M
3832-04 Bernard, A Kira 20011212 F
4920-04 Bernard, Syn Juna 2001.09.20 F
2171-04 Berry, Mary 1956.05.03 F
123chestd beth 2003.07.24 M
2156 blake van mol 2003.08.28 M
187220 BRAHDLEY,CHRISTY 1969.07.04 F
4503 brooks anetra 2003.08.10 F
4529 brown, damion 2003.08.21 M
4912-04 Brown, Dannon 2003.11.25 M
4625 Brown, Deontae 1962.07.28 M
4624-03 Brown,Mark 1994.11.01 M
439 27 0086 butlerleonard 2003.12.22 M
3911-04 caldwell, Tyler M
2624-03 Campbell, Tracy 1973.04.29 F
n1a? arter Bubar 2007 N 21 F T

J of

Select | Cancel | [%
A

Figure 3-39 — Patient Search Results

Select the desired patient by clicking the left most column of the desired patient. In
this case we will select GLENN with patient ID 1. After the appropriate patient is
selected push Select to enter that patient’s information in the Radlink patient
information fields or push Cancel to retry the search.
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E Patient Information

X

Patient Information

Hame |AHI]ER50H,HHALIAH

Accession # | |

Patient ID |1450-03

Birthdate | 8/2211998 v |
Sex |F v|
Study Date | 3 272004 v|
Study Desc | |
Reason For |
Exam
Referring | |
History | |
Hospital | |
Station Hame | v|
Modality |01 v|
Priority | | v|
Status | |

ExamID |1 |

Auto Clear?

b3

o HSaue-Exlt‘ ‘ Save ‘

Figure 3-40 — Patient Information Screen
In the above example, the Patient name, sex, birth date, and patient ID are populated
with the results of the patient search.

One can also perform patient searches in the Modality Worklist.
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Eﬂ.adlink Patient Search -0 x|

PACS Host Patient Hame |
PACS Ho=t
PatientID |
Sex I j

SEttingsl Query | Cancel |

Figure 3-41 — Patient Search Screen

One should first click the Search Button on the Radlink screen to bring up the
Patient Search Screen shown above. The PACS Host list is able to accommodate
both patient searches as well as modality worklist searches. One creates a modality
worklist host by clicking Settings:

ﬂﬂadlink Settings ;lglil
Alias HosztAlias I Host? j
IP
PACS Host [127.0.0.1

Port
[108

Chent Title
|eRadiink

AE Title
|Pacs

Search Type ndality Worklist e

Hew | Delete |

Save | Cancel |

Figure 3-42 — Modality Worklist Search Settings
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One should then fill in the IP, Port, Client Title, and AE Title. One then should select

either “Patient Search” to do patient searches, or “Modality Worklist” for Modality
Worklist searches.

Eﬂadlink Settings ;lglil
Alias HostAlias I Host> j

P

PACS Host [127.0.0.1
Port
[108
Client Title
|eRadiink
AE Title
|Pacs

TR b odaity workiistjod

PACS Patient Search
Modality Worklist
Local Patient Seal h

Save | Cancel |

Figure 3-43- Search Type Settings

4

One should then click save to exit the screen and save the settings. Assuming
Modality Worklist was chosen for “Host2.

If worklist entries are found, the following screen will appear:
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ﬂ Search Results E”E”‘s__q

patients |
Patient ID Acc # Patient Hame Birthdate Sey
1 1 M
STRAMPFER,CL 610539861 19141020 M
PO306 Alice Lila 19690928 F
P0155 AndersontTim 19600302 M
PO152 Bailey*Hicole 19600315 F
PO105 Barnsley®), 19781215 M

615100433 | BLACK*MITCHELL 19571218 M |
279289521 BLUEDORN*JOHH 19350909 M
PO208 Boynton*A. 19750221 F
Po221 Branson"S. 19381130 M
PO219 Brown"Michael 19430216 M
PO220 Brown"Sarah 19361024 F
P0123 Buxton*Steven 19700203 M
558269940 CAPOVILLAMIKE 19230818 M
PO110 Carly*a. 19650810 F
PO102 Chrig Matthews 19531212 M
PO104 Christiangson"B. 193099 M
P0112 Clarck*J. 19500515 F
136044 COOK*MINNIE 19181111 F
DnAa7F T anyt AQE AN F bt

< >

[

Figure 3-44 — Search Results

One then selects a patient from the worklist and clicks Select. The Patient
information is then filled out in the Patient Information area of the Radlink screen:
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E Patient Information

x]

Patient Information

Hame |BLACI{“MITCHELL

Accession # | |

Patient 1D |E1 5100439

Birthdate | 10/27:2004 <

Sex |M v|

Study Date |11/ 42009 v|

Study Desc | |

Reason For |
Exam

Referring |Glenn Crosse

History |

Hospital |Rﬂdlink Memorial Hospital |

Station Hame | v|
Modality |CT v|
Priority | Hormal v|
Status | |

Exam D |1 |

Search

Figure 3-45- Patient Information Screen

Notice that the accession number is then filled in. Modality Worklist items must
contain an accession number.

The third patient search supported is “Local Patient Search”. This search technique
utilizes a client side patient database. The population of this database is performed by
clicking the save button on the patient Information screen.
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The fourth patient search supported “Local Modality Worklist”. To utilize this search
type one should change the settings on the Radlink Patient Search screen:

Alias HostAlias Host1 "
IP
127.0.0.1
Port
108
Client Title
eRadlink
AE Title
PACS

Search Type v

PACS Patient Search
Modality Worklist
Local Patient Search
Local Modality Search

Hew

Save | Cancel |

Figure 3-46 — “Local Modality Search”

A

The Host Alias, IP, Port, Client Title, and AE Title fields are ignored for this (as well as
Local Patient) search. When the search is performed, the system will load the file
“C:\Documents and Settings\All Users\Documents\eradlink\patients.xml” file. This file
contains the information for all patients returned in the patient info search screen.

The file can be dynamically loaded or altered by applications external to the Image
Acquire application. The file format is xml. The following is an example Patients. XML
file that contains two entries:

<?xml version="1.0" encoding="utf-8"?>
<ArrayOfPatient xmins:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<Patient>

<name>1</name>

<accession />

<id>1</id>

<birthdate>20040324</birthdate>

<sex>M</sex>

<examDate>20040423</examDate>
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<description />
<reason />
<referring />
<history />
<hospital />
<modality>OT</modality>
<priority />
<status />
<examlD>1</examID>
</Patient>
<Patient>
<name>1</name>
<accession />
<id>1</id>
<birthdate>20040325</birthdate>
<sex>M</sex>
<examDate>20040423</examDate>
<description />
<reason />
<referring />
<history />
<hospital />
<modality>OT</modality>
<priority />
<status />
<examlD>1</examID>
</Patient>
</ArrayOfPatient>

Please call Radlink support if there are any questions on the file format of the
patients.xml file. All fields must be present in each patient. The date fields must follow
the DICOM date format rules of YYYYMMDD. If the day or month is one digit, force it to
be two digits as shown above, for example, April 23, 2004 is formatted as 20040423.

The permissible values for the priority field are: blank, 0,1, 2, where 0=normal, 1=high
priority, 2=low priority.

When the patient info “Query” button is clicked, all patients defined in that file will be
displayed. The patient information fields will then be subsequently automatically filled
out with the field values contained in that file. This is an alternative implementation of
the modality worklist search that doesn’t require the rigid DICOM Modality Worklist
Communication protocol.
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ﬂﬂadlink Settings ;IEIEI

Alias HostAlias [ Local Search Host |
IP
PACS Host [127.0.0.1
Modality Host Port
Local Search Host L [108
Chent Title
|eRadiink
AE Title
|Pacs
Search Type I al Patient Searc vI
PACS Patient Search
Hew Modality Worklist

Local Patient Search

Save | Cancel |

Figure 3-47 — Configuring “Local Patient Search”

4

In the above figure, The Search type is set to “Local Patient Search”. IP, Port, Cient
Title, and AE Title parameters are ignored.

The query techniques are similar to PACS Patient Search and Modality Worklist Search.

The following is and example query:

Bl radlink Patient Search =101 x|
PACS Host i
Patient Name fwe

Local Patient Search

Patient ID |

Sex I j

Settings | % Query | Cancel |

Figure 3-48 — “Local Patient Search”

4

In the above figure, a query for all patients whose name starts with “W” is specified.
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Patient ID | Patient Hame | Birthdate | sex
r 5-( WARD, JOHH 1927.03.15 M
1128-03 WARD,JOHH 1927.03.15 M
2246-03 ware,iam 1960.04.08 F
1173-02 hatlet tina 2003.08.07 F
360 atley 2 2003.07.27 M
123 wiggins 2003.08.10 F
563-04 william, Alfred 1926.06.23 M
441403 williams, kalvin 2003.08.21 M
456403 williams,crystal 1990.04.04 F
4575-03 Williams,Geneva 194412.22 F
4314 williamsmike 2003.08.19 M
4517-03 WILSOH CAMERON 2003.08.13 M
805 winters doris 2003.09.15 F
805-03 winters, doris 1917.12.22 F

Select | Cancel |

Figure 3-49 — “Local Patient Search”

As shown above, all patients whose name starts with “W” is returned. One should
select the desired patient by clicking the “Select” button. The Patient information is then
populated on the Radlink Main Screen. If the patient is not listed, one should click
cancel. One then must manually enter the patient information on the Radlink Acquire
screen. When the study is sent, that patient information will be added to the database
for subsequent retrieval.

The “Station Name” drop down list is populated with the contents of an XML file that is
user provided. If this file is not provided, the operator can simply type the station name
into that Combo Box.
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B patient Information E|

Patient Information
Hame |Glenn Crosse

Accesszion # |GEG

Patient D 1
Birthdate |12:311983 w
Sex (M v
Study Date |12/ 9.2004 w

Study Desc | A Study Description

Reason For
Exam

Referring Dr. Jim Bob

A Demo

History |A cronic History of Demos
Hospital |5t. Glenn's Memorial

Station Hame | AE_LAPTOP w

Modality |SC w %
Priority | High w
Status ||

ExamID |1

Auto Clear?

‘Sa\re-Exﬂ

Save
Search ‘ ‘

Figure 3-50 — Patient Information Screen

The station name field is a “sticky value” field and will be automatically populated
with the last value entered.

The format of the xml file would look like:

<?xml version="1.0" encoding="utf-8"?>
<ArrayOfStationName xmlins:xsi="http://www.w3.0rq/2001/XMLSchema-instance"
xmins:xsd="http://www.w3.0rq/2001/XMLSchema">
<StationName>
<name>AE_LAPTOP</name>
</StationName>
<StationName>
<name>Another Station</name>
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</StationName>
</ArrayOfStationName >

The above example file has two station name entries: AE_LAPTOP and "Another
Station". The file name is to be called StationNames.xml and is to be located in the
eradlink folder which is in shared documents.

The file format of the StationNames.xml is a Industry Standard and can easily be read,
created, or modified with Microsoft Excel or any other program which supports this
standard.

Please note that if either Study Date or Birth Date have been set as required fields the
following behaviors will occur upon the click on the Save or Save and Exit button::

Study Date — If the date entered is “Today’s Date” and error alert will be presented.
Birth Date — If the date entered is “Today’s Date” and error alert will be presented.
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Segmentation

There are now three buttons associated with the segmentation procedure. “Display
Template” displays the chosen template on the screen. “Segment” will segment the

image according to the chosen template. “Resize Template” will start the template
resize process.

The thing one should do is to click the button “Display Template”. After clicking the
button, thle button becomes a “Hide Template” button for later hiding the template.
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Figure 3-50 — MRI With Template Visible

The next step is to Resize the Template (if necessary) by clicking the “Resize

Template” button. Resizing the template is a two step procedure. First one
positions the template then resizes it.

When the Resize Template button is clicked, the chosen template should be moved
to the proper position on the image. Position the template on the upper left of the
image. When positioned properly, Left click the mouse ONCE. The template is now
in resize mode and the size of the template will follow the mouse.
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Figure 3-51 MRI With The Template In Resize Mode
One should then navigate to the lower right of the image. If the image is too large
for the display, use the scroll bars on the image to make lower right corner of the

image visible. When the template is resized properly, click the left button of the
mouse ONCE. This finishes the template resize procedure.
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Figure 3-52 — Positioning the Template

Note that in the above figure, the image has been scrolled to make the bottom right
corner visible. Also the left mouse button is about to be clicked when the template is
aligned properly on the bottom right side of the image.

One can now segment the image by clicking the Segment button. After segmenting
the image, one should hide the template by clicking the Hide Template button. To
enlarge the segmented images, click the zoom drop down. Perhaps 150% is the
proper size for viewing.
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Figure 3-53 — Enlarged Image Segment

One can now click the “CINE” button to see the segmented images in a Movie-Like

fashion. The CINE settings can be adjusted by clicking the menu item,
Settings—>Cine.

==

b el

Figure 3-54 — Radlink Settings Menu Items
The following cine settings screen appears:
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E Cine Settings

Cine Image Delay |m |

Repeat Count |1 |

Figure 3-55 — Cine Settings
“Cine Image Delay” is the number of milliseconds each image will be displayed. 100 is
a typical number for this setting. “Repeat Count” is the number times the images will be
displayed in a loop fashion.

After the study has been read with the viewer, a study report can be completed and
sent.
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I mary.doc - Microsoft Word o ] 24|

File  Edit lnsert Format  Tools  Table  Window  Help Type a question for help = X

DEHRS S Q|IVE| L RE I I9-18 EHE H|F 100% - | EHeesd i -
EE"'!"'}"'!"'?"'!"'3."'!"".‘"'!"'5."'!"' -
Radlink Medical Center

1151 Cherry Circle
Lalte Ozwego, Oregon 970354
[503) 697 2218

Dragnoztic Inaging Setvices: Glenn Crogze, MD.,D.ABR
H-Foy, Compruted Topmography, MRT & Ultrasourd. Raliologist
Patient: Mary Crosse Date of Examination: 27772004
Date of Birth:  D8/15/1850 Examination:  Ankle
Requestar:  Dr Toung MR Mo 1

Ankle:
Baone architecture and alignment are normal. Ma fractures or dislocations are seen.

MPRESSION:
Marmal.

Signed electronically, Glenn Crosse, MD. DABR.

B
E
o
¥
BRI 2
Page 1 Sec 1 111 Ak 1" ln1l Cal1 REC TRE EXT OWYR English(U.5 4

Figure 3-56 — Completed Patient Report
The above figure displays a patient document (shown using Microsoft Word) created

with the patient results document creation facility. One creates a document by
clicking the menu item: View->Patient Report.
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Figure 3-57 — Patient Report Menu Choices

To create a report, click the menu item File>New. The following screen appears:
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—Institution

L1011 WRadiink Medical Center]

Acddress |1151 Cherry Circle

City |Lake Osweqgo State IOregun Zip |9?l]34

Phone |(5|13) 697 9218

—Services
Service Title I[Iiagnus’tic Imaging Services Radiologist IGIenn Crosse, M.D., D.AB.R.

Services IX—Ray, Computed Topmography, MRl & Ultrasoun Title |Radiulngis‘l

— Patient Info

Name Exam Date |

|
DoB | ExamID |
Requestor |

— Exam Results

Body Part Description

Add Body Part
I ]v

Add Body Part
To Report

Impression

2|

Exam | Exit | Edit Body Parts | y

Figure 3-58 — Create Patient Report Screen

The Institution and Services fields are persistent and only have to be entered once.
After entering those fields, one selects the exam that is to be documented by clicking
the Exam button. The follow screen then appears:
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Figure 3-59 — Study Selection Screen

One then selects the study to be documented and then clicks “Exit”.
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—Institution

Institution |Radiink Medical Center

Acddress |1151 Cherry Circle

City |Lake Osweqgo State IOregun Zip |9?l]34

Phone |(5|13) 697 9218

[ Services
Service Title |piagnostic Imaging Services Radiologist [clenn Crosse,MD., D.ABR.
Services IX—Ray, Computed Topmography, MRI & Ukrasoun Title IRﬂdiDngis‘l
—Patient Info
Name  [MaryCrosse Exam Date [27/2004
DoB [08:151950 ExamID h
Requestor |or.Toung

— Exam Resulis
Body Part Description

Add Body Part
Bione architecture and alignment are normal. Mo fractures or dislocations are

I vI ZEEm.
Add Body Part
To Report

Iormal.

Impression

Exit | Edit Body Parts | y

Figure 3-60 — Filling out Study Results

If a second body part was examined as part of this study, one should select the body
part in the Add Body Part drop down list. One can also type one in if needed. After the
selection is made, one should click the button, “Add Body Part To Report” button. The
description and impression for that body part should then be displayed. One can also
modify the description and impression for a custom report.
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—Institution

Institution |Radiink Medical Center

Acddress |1151 Cherry Circle

City |Lake Osweqgo State IOregun Zip |9?l]34

Phone |(5|13) 697 9218

—Services
Service Title I[Iiagnus’tic Imaging Services Radiologist IGIenn Crosse, M.D., D.AB.R.
Services IX—Ray, Computed Topmography, MRl & Ultrasoun Title |Radiulngis‘l
—Patient Info
Name  [MaryCrosse Exam Date [27/2004
DOB 0811511950 ExamID |
Requestor |or.Toung
— Exam Results
Body Part Description
Add Body Part
Tww views of the foot show bone architecture and alignment are normal. Mo
Ankle ) :
Foot - fractures or dizlocstions are seen.
Add Bpdy Part
To ﬁpuﬂ
Iormal.
Impression

Exam | Exit | Edit Body Parts | y
Figure 3-61 — The Completed Study Results

Now that the study information has been entered, one clicks “Exit”. Note that no typing
was performed in this example.
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File Edit
Radlink Medical Center [
1151 Cherry Circle
Lake Ogwego, Oregon 7034
(503 627 9218
Diagnogztic Imaging Services: Glenn Crogze, M.D., DLAB.ER.
X-Regy, Computed Topmography, MRI & Ultrasownd. Radwlogist
Patient: Mary Crosse Date of Examination: 27772004
Date of Birth:  08/15/1950 Examination:  Ankle
Foot
Requestar:  Dr.Toung MR Mo 1
Ankle:
Bone architecture and alignment are normal. Mo fractures or dislocations are seen.
IMPRESSION:
MNarmal.
Foat:
Two views of the foot show bone architecture and alignment are normal. Mo fractures or dislocations are seen.

IMPRESSION:
Marmal.

Ad|

Figure 3-62 — The Completed Study Results Report

The report is then shown. To save the report in Microsoft Word (any document editor
that supports “RTF (Rich Text Format)” click the menu item File>Save.

Then enter the file name for the report and click save. One can now send this report as
an attachment in an email to complete the Study Report Documentation process.

One can also add body parts to the drop down menu lists for future use by clicking the
“Edit Body Parts” button. When that is done the following screen will appear:
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Figure 3-63 — Edit Body Parts Screen

One can delete a body part from the list by selecting the body part and then clicking the
right button. A delete Menu item will appear which one selects to delete the body part
from the list. One adds a body part to the list by typing the body part name in the body
part input text box then clicking the “Add Body Part to List” button:
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Body Part Impression Descriptian
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Figure 3-64- Adding a Body Part
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After the body part is added, one should add the default normal impression and
Description for the body part. After the list is edited, one should click the “Save” button.
Click the “Exit” button to cancel and exit this activity.

After the body parts list is edited and saved, it is reused in both the Radlink Image
Acquire main screen (the body parts drop down list) and on the create patient reports
body parts drop down list.

NOTE: When the list is edited, the file containing the list should be distributed to others
using the Radlink System so they will have the same body part drop down choices. The
file is named "normalBodyParts.xml” in the eradlink program files directory (usually
located in “C:\Program Files\eRadlink”.

ALSO NOTE that is preferable that the Radlink Acquisition Station have the same
normalBodyParts.xml file. If the technician scanning the films chooses a body part
from the drop down list and the list is the same as the Radiologists reading the
study, work will be saved as the normal template body part impression and
description will be automatically filled in during the report creation process.
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(T Reverse Order

The menus are designed to enable the main Radlink screen to be operated without
buttons. The menu items are:

E\éan

Patient Info.
Send Study
Send Status

Seqgrentation
Flip Image

3
3
Rotate Image
Delete k
Sicale »

Creake Series

y GoTo 4

v Show Buttons CINE

v Show Patient Info

w Show Caliper #nnotate

Show Histogram Measure
v Show Orverlays q
Megative Studies Completed M Change Password | NI
. Craw Test Image Loam 4 Patient Report Acquire ::Z:: uuuuuuuu duct

File Settings View Tools Reports Twain Login Help

The File menu items contains the item “Retrieve Study”. This menu item has two
sub menu items:"Radlink” and “PACS”. The Radlink menu item retrieves images
from the Radlink Image Express server. Pacs, which will be supported in an
upcoming Radlink release, retrieves studies from a selectable PACS server.

1. Exams can be burned to CD with Radlink Image Acquire. The images scanned
and saved by the Radlink Image Acquire application are burnable to CD using
this facility. To launch the CD Burner software, one should either select the
menu item File->Open Archive or File>Open Study menu item:
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Figure 3-65 - Radlink Image Acquire File Menu

Choosing the Open Archive menu item brings up the following screen:

T Opam Dcem Files

L

Directory” CiDocuments and Seltingsiall UsersiDocumentstier sdinklimage Archive

i Copy Progress
Opan Selecied Shody Emn o OF Bac b Camcal Dalein Samad
BIEOM Bwlei
Pl Pl Wity | Dascrigtion [ L Retaming Bk | Dae )
F nphaasbai, skher l\'.!: r.'!:ll:r::ll.nu:“ﬁ farmp iﬂﬂ.d.‘l.ll DF I.h'\-l:dI :n.'.um
Figure 3-66— Radlink Open Archive
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One can select multiple exams by clicking the arrow on the left column of the exam and
dragging the mouse vertically. The following is a set of exams about to be burnt to a
CD:

|7 O Dicom Filas == = |
Directony: ©\Decuments and Ssttings\all UssrsiDocumentsberadinklimags Archive
Fine Copy Progress: |
L Fatien il Total Exams Sice: 1M
Opan Sahacted Slusy | | Bun €0 | [ OB Facha | [ Camcal | [ [ | [ Semal

L s
Foilni leare: ioaindy | [ussoriphion Pk I Elridaie Fierving Famius [uaie #

| ALLEWSFURI, SANDRS, [t ] HEALYMTA, 1E4EET 11,071 342 ROREY Urrasd  4EGT04
AHCRADETELITABETH or AP PAR D006 [ 5 BOHECTER Wessd  EHEO0
APOLMAR-GIA ST [= DEEETTY 100 298 Urrasd  G11GDM
EELTERE, MERH B T CHEST Wi B e D, WAL Wessd LT
BLACKTHELL cr Hamd™1 PACHE OOt SPIRAL FISID3  ZNEn3aT FHAZID Umrasd  S1AGD
ELLEDKIRHKHN W LaprerTmAing RN AEIaNE PLATT [CEL S = E L L
BOMGES TONEEH ] Iong b Tam 1400057 1011335 BAHER FAL Urasd  T12G004
BYERLEY WeRTHIERITE 13 o ] FiTEmiel FE iwssd BT
CAMPBELL T WD cr T ERMPEMOLET Umrasd  W1GD04
CENPEEL LR WD T Todrida ERTRERLET wssd B0
CARTVILL &V = Abroran AL PHASE SEEGEEGMD  ANEN 921 HET Urasd 31 TGO
CERTER, SHIRLEY BE: BCLICES FiLAS A0TEED EURLE T ] KIVCE Unwssd 10T
CODICTMME or ARCRA 136044 Hnmaa Urasd  1.GDD4
[LEFS Y HEREER cr LTFLERE FaAM EEEZED WARHE Lirwaad B0
DETORD, ALEGRE, v LEFTHE AN 12e=ngn WOHNOLD Urrasd 4116004
FLAHDERS, [Lewils L] CERYICEL ST FLEAL ] COPER Lirwaad A0
FRESE A or HERDWAWID 454.7T.0EEE PAESTHA, Urrasd  SOELGDM
HACHETTRICE PH W bR QL] ESLE ] Ura S aHED Wessd LRI

¥ [% GOMZALESFLYIA, us Toen AN Urrasd  4EGDD4
HOPPPATROE W Tiack_sT- B TR GEIETIE 2G04 BEF Wwssd  BNAEIOG
SHES AT ] mmarighl 4041 E 1GE T Urasd  T11GD0
el Rl B 1 Unwssd GG
LAMGGLEHDH, us 11EM48 ER Umrasd 4115004
LAZETER-TARRELL T Abaiarerei AL PHASE MRS AHEGGa) CHMH nessd 27 w

i »

Figure 3-67 — Selecting Exams for CD Burning

One should then click the Burn CD button. The system will then prompt you for CD
label information. This should be the label that is on the CD Case. If the label is to be
saved into the Radlink database, click the “Save Into Database” button. The CD Label
Database is used to retrieve studies from the CD Archive. If one does not wish to save
the Label information into the database, he should click the button “Cancel”.

o~

% Enter CD Label mEx|

Mary's X-Rays|
[ Save Into Database ] %

Figure 3-68 — Entering the CD Label
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After clicking “Save Into Database” the file copy to the CD process then begins:

[ Do Do Files =J2d|
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Figure 3-69 — Adding Files to the CD

One should ignore the windows pop up balloon that indicates that files are being written
to the CD.

j‘,} You have files waiting to be written to the CD. | *

To see the files now, click this balloon,

Figure 3-70 — Windows CD Prompt

When the files are all added to the cd a CD Burner window will appear:
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5 CD Writing Wizard

&

Welcome to the CD Writing
Wizard

This wizard helps you write, or record, vour files to a CD
recording drive. %

Tvpe the name you want ko give ka this C0, or just click Mext
ko use the name belov,

D name:

Yolume 10

Mew files being writken to the T will replace any Files
already on the COif they have the same name.

Close the wizard after the files have been written

[ Mext = ] [ Cancel

Figure 3-71 CD Writing Wizard

One should enter a name for the CD and click the button “Next”.

5 CD Writing Wizard

Please wait...

adding data ko the CD image. ..

(

Estimated time left: 4 minutes

Zancel

Figure 3-72 — Burning the CD
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When the burning process is finished, the CD will automatically eject. One can then
view the exams by inserting the CD. The Radlink viewer will then be invoked:

- : - - - = = fud [T ra—

Figure 3-73—- Patient List

The Exam should then be selected by checking the check box to the left of the exam
folder. Then one should click the Button “Load”. The exam can then be viewed:
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Figure 3-74 — Viewing the CD Exam

One can also view the exam using the Radlink Image Acquire application.
One should start the Image Acquire application the click “Open Study”. Then click the
Change Directory button and navigate to the CD:
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Figure 3-75 — Opening an Exam With Radlink Image Acquire

After navigating to the Exam on the CD, click OK. Then select the Exam to open and
click Open Selected Study.
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Figure 3-76 — Viewing the Exam With Radlink Image Acquire

One can choose their own viewer to be burned to the CD rather than the Radlink
provided viewer by changing the settings in Image Acquire. The settings can be
opened by clicking the menu item “Settings—> Dicom File Settings”.
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¥ Dicom File Settings E]@ﬁ

Compression

noCompression w
Quality 90
DED“’I 16 W

CD Sethings

Full Path Hame of Yiewer to Include:

nd 5ettings\All Users\Documentseradlink\Yiewer\cd¥iewer. exd E

Save

Figure 3-77 — Dicom File Settings

To utilize a different viewer when burning a CD, enter the full path name of a viewer to
burn rather than the Radlink provided viewer. Entering in the full path name is
facilitated with the folder button to the right, which brings up a file navigation screen.

The Image Acquire application can now save exams in Part 10 Format. This feature
should not normally be used. To turn on the feature, check the “Part 10 Format” check
box. All images saved by Image Acquire will then be saved in Part 10 Format. Part 10
Format images have a different DICOM header and file naming convention. A
DICOMDIR file is also generated when the Exams are saved. All exams burned to a
CD with the CD Burner facility are in Part 10 format.:

Ira USER MANUAL Page 104

Radlink



L oy
¥

Fle Edb Ves Feworbes Tods Hap
|
et = 53 (% Dhsswn Foders. | [TTE] -
i gl w|“@ kg ™ 1T i A E_- & sl o'
E - B P e Ty Lste poeiihad LEC RN |
m— .ﬂ' Fili=g Dippwvemd iy com fhee LT
(Y 'k e e o ED === Fils Fabder HINEOE LLFA s Oty orithe O
CaeaiET Rl Pk WINEO0R LILLFM  Fles Cumently oritha
Fite i Foldes Taskd- |2 | e B it Rkl H1SE0E P Filgs Dirinidy onohes 10
_ Lok Pl Pkl WINE0E LIILFM  Fles Dumaidy onithe (0
-] 'r};‘ut:""*’“" e LabsEn Fie Fibdss WANEO06 LILLFA Files Qupesly peiche 5
el ST Fie Fabdar WANEOE LU Fles Cumsndy onths 00
- TR Fie ol WANEOE LILLFA Fies Ourmstdy onithe (0
CamTHE Fi Rkt WINZD0E LI P Fles Curmently onthe T
T - % Lol Pl Pk WINTO06 UL P Fles oty onthe (0
s W tuskon nd LEE Sehpbfavesion  WINZOOR LA P Fles Cumently orithe (0
3 My M noHR I7LEE Fis WINZO0E IIPM  Fles Cusvently orithe
] My Dacunerss Mernind ko GER [0 TIEE0E 1132 6 Fles Cusvanitly pethe
) s I s
Ny e stk Maces
Dot A
Folumma 1B {E:h
I Dyt I‘.?
P st C0FS
Fraes Spoe1 432 M8 =

Figure 3-78 — Example CD that is Written In Part 10 Format

2. We have added a CD Archive Database, which will enable one to index the CD’s
into the CD Archive for easy retrieval. One can now age off DICOM studies from
the Image Archive onto CD’s and later retrieve the studies from the CD’s with the
CD Study Database.

To view the archive, click the button “CD Archive” on the “Open Archive” or “Open
Study” screen:
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Figure 3-79 — “CD Archive Button” on the Open Archive Screen

After the button is clicked, the following screen appears:
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Figure 3-80 — CD Archive Screen
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The sceen lists all studies in the CD Archive, sorted by Name. The list can also be
sorted by ID, or Study Date by making the desired selection in the Sort Combo Box:
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Figure 3-81 — CD Archive “Study Sort” Combo Box
The CD Archive studies can also be filtered. One can choose to display all patient

studies by the starting letters of the patient name and/or all patient studies by the
starting characters of a given patient ID:
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Figure 3-82 — Patient Studies for All Patients Whose Name Begins with “6”

After the desired study has been located, the CD Label is displayed on that row.
This is the label of the CD on the shelves of the CD Library.

3. One can export the CD Archive Information to a tab delimited test file by clicking
the “Export” button. After the file has been exported, it can be imported into
programs such as Microsoft Excel for report generation.

4. After the studies have been aged onto CD'’s, the can be deleted out of the
Radlink Image Archive by opening the Image Archive, selecting the desired
studies, then clicking the “Delete Study” button:
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Figure 3-83 — Deleting Studies from the Radlink Image Archive
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Figure 3-84 — Selecting the Twain Paper Scanner

After the scanner is selected, one should then click the menu item “Twain->Acquire” to
begin the scan preview and scan process.

The paper scan is then attached to the study in Dicom Format:
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Figure 3-85 — Study with Written Attachment

One can retrieve studies resident on PACS for viewing or other usages such as CD
Burning. To retrieve a study click File->Retieve Study->PACS menu item on the
Radlink Image Acquire screen. The following screen appears:
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Figure 3-86 — PACS Study Retrieval Screen

One must first enter the settings for PACS study retrieval at both the client side as well
as the PACS system.
E Ouery Settings E@@

Communications Settings

PACS IP 55.11?.85.15

PACS Port 104

Client Title |AE_LAPT opP

Receive Pot 109

|
|
|
PACS (AE) Title |AE_WINFX |
|
|

Comprezsion |nu[:umpressiun w

| Ping | | ok |

K
Figure 3-87 — PACS Query Retrieval Settings Screen

The following parameters need to be entered:

PACS IP — This is the IP of the PACS server.
PACS Port — This is the port the PACS server listens for requests. Typically the
port is port 104.
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Client Title — This is the name that the PACS system will need to return the
requested study.

Receive Port — This is the port that the PACS system will return the study on.
The port number must be unique to the client machine.

Once the client side settings are entered, one should click the button “Ping”. This will
send a DICOM Ping to test connectivity to the PACS server.

To set up the PACS server, a destination will need to be added. This is the destination
corresponding to the Client machine that requested the study (the Radlink System). To
do this on Centricity one first opens that application. Then select the menu item
Connection—>Destinations. The following screen appears:

Destinations E

2 Item(s] Cloze

Mame | Description | Host Mame | DIcOM AE ... | Add

AE_LAPTOP E5.117.85.196 AE_LAFTOP

RADLINE 127.0.0.1 RADLIME, Copy
b iy

Delete

el

Help

Figure 3-88 GE Centricity Destination Settings Screen

In the above figure, the defined destinations are displayed. To enter a new destination,
click “Add”. Enter the client side information such as IP, Port, and AE_Title information
(this should match the clent information entered in the Radlink System). The
information for this example is as follows:
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Destination Properties

Identification | Connection Parameters | Transmission Parameters |

MHame F LAPTOP

Drezcription I

Institution M ame I

Institution D epartment Mame I %

Station Mame |Iapto|:u

0k I Cancel | Help

Figure 3-89 — Destination Identification

The Connection parameters are:
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Destination Properties

Identification  Connection Parameters | Tramsmission F'arametersl

Haoszt M arne =Nk

DICOM AE Title [4E_LaPTOP

DICOM Part 109

Backup Destination |<n|:|ne> j

0k I Cancel | Help |

Figure 3-90 - Centricity Connection Parameters

One should note that the Host name is the IP address of the Radlink Image Acquire
workstation. The port is the port specified in the Radlink settings described. The
DICOM AE Title is the “Client Title” entered on the Radlink system.

After the communications settings are input, one can now perform the Radlink Study
Query Retrieve. Click the Query button to get a list of all studies on the PACS server.
To filter the number of entries returned, enter the first couple of letters of the patient
name and/or the first character or two of the patient ID, and/or the study date from/to
information. The following is an example of study information returned after clicking the
query button:
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One should select the desired study and click the button “Retrieve Study”. The study
will then be downloaded to the Image Archive directory and subsequently brought up on
the Radlink Image Acquire Screen:

Radlink

USER MANUAL

Figure 3-91 — PACS Study Query/Retrieve Screen

Figure 3-92 — Study as Retrieved From Centricity
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Annotation

One annotates an image by clicking the “Annotate” button then clicking the position
on the image where the text is to be located. A black input field will then appear at
that location. Type the desired text into that input field:

Figure 3-93 — Creating an Annotation

One should then tab out of the input field. The following is the result of tabbing out of
the input field in the above example:
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Figure 3-94 — Example Annotation

Measurements

One measures an image by clicking the "Measure” button then moving the cursor to
the start point of the measurement. Press the left button on the mouse and keep it
depressed until the measurement is completed. Move the mouse to the desired
end point and release the left button to complete the measurement. The
measurement line will follow the mouse with a rubber-band like effect. The
measurement text is dynamically updated as well.
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Figure 3-95 — Example Measurement

The measurements are in millimeters and are displayed with the font selected in the
Overlay Settings screen. Please note that measurements and Calipers are only
displayed for DICOM images that have the DICOM element: (0028,0030) Pixel
Spacing included. This DICOM element contains the number of millimeters per pixel in

both the horizontal as well as vertical directions.

Zoom
One “zooms” and image by clicking the zoom button then selecting the desired

magnification:
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Figure 3-96 — Selecting a Zoom Magnification

A zoom window then appears:

Figure 3-97 — Image Zoom
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The upper left corner of the zoom image corresponds to the mouse position. As one
moves the mouse, the image changes accordingly.

Calipers

One can turn the Calipers on or off bz selecting the menu item “View->Show Calipers”.

T

i
I

[l T T o

JiME pi0ERiR AR
[

Figure 3-98 — Displaying the Calipers

The calipers are 10 millimeters per division. This tidbit is displayed in the patient info
box at the upper left of the image. This dimensional information is important for
documentation purposes.

Series Support
One can navigate to a desired series or image by clicking the appropriate Series or
Image buttons on the screen. Using the above example, the Next Series button was

clicked:
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Figure 3-99- Series Navigation
The image list is then changed to show all images for that series. When one clicks the
CINE button, all images in the selected series will be displayed in a Movie-like fashion.

One can create a new series which is placed at the end of the study by clicking the
“Create Series” button. This is extremely useful for segmentation of films each in a
separate series, thus properly emulating the modality that generated the films. The
following exemplifies this procedure.

Assume one has two films that are to be segmented. One should scan in the film and
select the proper template:
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Figure 3-100 — CT Film with Template

One should then click the “Segment” button, which will segment the film as it originally
came off of the CT modality. These images would then go into series number one:
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Figure 3-101 — Segmented images for Series One
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The next step would be to create a new series by clicking the “New Series” button.
One should then scan the next film and choose the appropriate template:
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Figure 3-101 — CT Film Scanned into a New Series

One then segments that image by clicking the Segment button:
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Figure 3-102 — Segmented Images for Series Two

Now when the CINE button is clicked, only the images for the series is displayed as
opposed to all images in the study as was the case before Radlink Release 4.2. The
images will also be displayed properly at the remote PACS viewer after they are sent,

with the images broken into the proper series.
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DICOM Router

To view the router settings, one should either click on the Status button located on
the Radlink Image Acquire screen, or click the Router icon in the system tray at the
lower right of the screen. The following screen will then appear:

E Radlink Dicom Router
File Edit Login Help

Dicom Transfer Progress | ]

HostiCiueue v| |Pending v

Dicom Destination Quewe

- Patient Mame | Patient [0 | D escription | File Size | Date | Pririty

Senders Idle | Receivers Idle | Ho Send Errors |

Figure 3-103 — The Radlink Dicom Router
One should then click the menu item Edit-> Settings for the router settings screens.
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ﬂ Radlink Modality Router, g@@

Instructions Modalities Destinatiuns| Rules| Router Status

Follow these steps to set up the Radlink Router:
1. Create all destinations that you may wish to send messages

2. Create the modalities. You must select at least one default
destination for each modality.

3. K desired, create rules that apply to a specific modality, all
muodalities, or any combination of modalities. The rules are
translated into a readable format as they are being formulated.

Please note:

1. The rules override the default destinations for the modalities. If
the rules produce no destinations for a message, the default
destinations for the modality sending the message will be chosen.

2. The rules are additive. If the combination of the rules produce
more than one destination set, the message will be sent each of
those destination sets.

3. To test your rules, click the Rules Test hutton. The use of this
feature requires any dicom file, renamed to Test.dcm, be placed in
the Modality InBox directory.

Figure 3-104 — Radlink Modality Router Instructions Screen

A Quick overview of the setup steps:

The instructions layout the necessary steps, to set up the router.

1. One must first create all of the destinations that the router, or Image Acquire,
may want to send Dicom images.

2. One then sets up all of the various modalities. It is important that modality have
a corresponding default destination. Also each modality must have a unique
modality AE Title.

3. Lastly, one should enter the rules that govern the router. If no rules are entered,
or no rules apply, the default destinations will be chosen for the route.

The rules override the default destinations. If a rule applies, the destination within
that rule will be chosen instead.
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Each rule contains its own set of destinations. If more than one rule applies, then
each of those destination sets for those rules will be sent Dicom Images.

The rules are not specifically tied to a particular modality. A rule can contain one or
more modalities and specify one or more destinations.

The Router also contains a log for all messages received and which rules were
applied.

The Router includes a rules tester which will facilitate the debugging of all of the
rules that are in the system.

One first clicks the Destination Tab to enter the destinations:

E Radlink Modality Router

Instructions Mudalities‘ Destinations Rules| Router Status

Destination Settings

Host Hame efilm w
Destinations IP [127.0.01
Port [4006
Mallencrodt
Radlink Client AE Title |ERADLINK

Host AE Title |EFILM

# Retries |3
Protocol |DICOM 3.0 w
Compression
noCompression w
(] Prompt On Send Failure
[ New ] l Delete I l Save And Exit ] [Dicnm Ping

Figure 3-105 - Router Destinations Setup Screen
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Destination Settings

Host Alias — A user chosen name of the PACS host. This name can be
modified by selecting the text in the Host Alias combo box
and retyping a new name. Changing the name will not
impact DICOM communications. Its purpose is for a more
friendly user interface. Note that the Host Alias names are
the names the user sees in the DICOM Spooler Host combo
box.

IP - Internet IP address. Usually a World Wide Web address, i.e.
www.eradlink.com. IP can also be the physical network node address.
The physical network node address of Radlink is 65.117.85.195.

Port — Port is the logical port of the PACS server. Radlink is currently
using port 107. Other PACS host will have different port
assignments.

Client Title — Client Title is the Client User Name. This User Name is
typically administered by the PACS host. Please call Radlink for
your Radlink client title.

Host Title — Host Title is PACS administered as well. The Radlink Host
Title is PACS.

Protocol — The normal setting “Dicom 3.0” is based on the RSNA 2004 standard
and is much richer in handling various modalities and PACS hosts. The
“Dicom 3.0 protocol setting supports image compression. The older
protocol is based on the RSNA 2000 standard. The protocol setting is
"Mallinckrodt”. This setting was added to accommodate older PACS
systems. This protocol does not support compression and doesn’t support
newer modalities.

Prompt on Send Failure? — An option to the router to not prompt on a send failure
but rather place the DICOM study in the cancelled queue after a number
of user defined retries. This is important for unattended operation

Compression — A variety of compression techniques are available.

The compression techniques supported are:

noCompression — Save the image uncompressed.

ipeg2000Lossless — Save the image using jpeg2000 wavelet lossless compression.
The number of bits stored will automatically be the number of bits in the image at the
time of the image save. The compression ratio to be expected is typically between 4
and 10 for jpeg2000 lossless compression.

ipeg2000lossy — This compression technique utilizes jpeg2000 wavelet lossy
compression and achieves compression ratios between 10 and 70. The
uncompressed images appear lossless in quality with this compression technique.
JPEG2000 will perform 8, 12, and 16 bit compression.
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jpeglossless — This compression technique uses the common JPEG lossless
compression algorithms. The number of bits in the compressed image can be set to
8, 12 or 16 bits. The compressed image typically have a compression ratio of about
5 to one.

jpeglossy — 8 bit Process 1 — This is JPEG 8 bit lossy compression. One can
select a quality factor to control the quality and resulting compression ratio. The
default quality factor is 90. (quality factor is set between 0 and 100). Rather good
compression ratios can be achieved with this compression technique but at the
expense of image quality. The uncompressed image will be 8 bit images of varying
levels of acceptability.

jpeglossy — Process 2 & 4 — This is JPEG 12 bit lossy compression. Like jpeg 8 bit
lossy compression, the quality factor can be set between 0 and 100. All of the
compression algorithms described above are DICOM compliant and will be
compatible with PACS servers supporting the DICOM standard for compression.

If the destination chosen is eRadlink, the compression options are “No
Compression”, “JPEG 2000 Lossy Compression”, and “JPEG 2000 Lossless
Compression”.
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Figure 3-106—- Image Compression Options
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The following figure shows a example list of destinations entered for our example:

ﬂ Radlink Modality Router, |Z| |E| E|

Instructions Mudalities‘ Destinations Rules| Router Status‘

Destination Settings

Host Hame | Dr. Jim Boh w

Destinati
estinations IP |65.117.85.199

Local Pacs Port 104
Dr. Jim Boh

Host AE Title |JIMBOB

# Retries |2

Protocol DICOM 3.0 w

Compression

|
|
|
Radlink Client AE Title |joe |
|
|
|

| noCompression v|

Prompt On Send Failure

[ New ] lDeIete l l Save And Exit ] [Dicum Ping]

Figure 3-107 — Router Destinations

One then proceeds to the Modalities setup screen by clicking on the Modality tab.

|ra USER MANUAL Page 131

Radlink



E Faacl lins. ki sy Bniiter

Hﬂuﬁlﬂl Modalitins Dﬁﬁﬁiﬂl Reles | Hoiter Stalits

léodality Fort Seitings

Muodality Hame |||.|.|;n.|. j
Modaliy [T ERADLK

Forl 14
I Archive - Mo Fonsandsey
L'ilﬂl'!llh (et piigan
Hadlink Pacs

Diliae Miw

Save Aind Exit |

Figure 3-108 — Router Modalities Setup Screen

One should then enter port information and default destinations for each of the
modalites that will be routed.
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ﬂ Radlink Modality Router, Q@g

Instructions || Modalities Destinatiuns| Rules| Router Status

Modality Port Settings

Modality Name | WinFX v
: :
=T Modality AE Title | AE_WINFX

Router AE Title AE_LAPTOP

Port | 108
[ Archive - No Forwarding

Delete ] [ New If Ho Rules Apply, Send to These
Default Destinations

[]loophack
efilm
[] Centricity

[ efilmwinfx

[ Save And Exit ]

Figure 3-109 — Router Modalities

The Name Combo box is the Radlink user defined name for the modality.

The Hosts list is a list of destinations that the Radlink system could forward the
DICOM image to. To instruct the Radlink system to forward the image to a host
destination, check the check box for that destination.

The above figure shows a modality that has been configured to send to the
destinations Radlink and LOCAL PACS..

One could also send the image to the Dr. Jim Bob by selecting it as well in the above
example.

The port setting is the port that the Radlink system will use to receive the DICOM
images from that modality. The modality should be configured to send to the IP that
is defined on this machine, the machine housing the modality router.
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The AE title at the sending modality must be set to the Router AE Title. The port
setting in the example above is 1005. There cannot be duplicate modality AE Titles
and the modality ports cannot conflict with other port settings within the machine.
The range of ports that can be assigned are from 1 to approximately 65,000.

To set up other modalities, follow the above procedure for adding and configuring a
modality. One could configure two different modalities to send to the same Radlink
modality port by configuring those modalities to send to the same Radlink port.

Note that if the Radlink DICOM Router is shut down, the Radlink system will not be
able to receive images. The Radlink DICOM Router is started up automatically upon
machine startup.

The next step is to enter the rules. One should now click the Rules tab.

| T alol=

Inchuctiges | Destinpfions Ill-l-lllllﬁl Aules  Houter Status
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Dafaul Rele Dozt Auils:
Soiietl il ki el B 1T
Ay agegly this rebe

Edtfule | CresssBule | Dolew Bele | [z
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Figure 3-110 - Radlink Router Rules Page.
To edit a rule, highlight the rule in the Rules List and click edit. One can also delete
a rule by highlighting the rule and clicking Delete Rule. To create a rule, click the
Create Rule button.
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Figure 3-111 — Rule Definition Page

One should select the all of the modalities that this rule addresses. Then one should
select the destinations. If the rule is to route based on DICOM information, enter that
information as well. If the rule is to apply at specific times, that should be entered as
well. To specify the times, select a time range item in the combo box. The following are
the choices:
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RI=TE
Rule Name: |Defau|t Rule
Send To These Locations From The Selected Modality
[1GE [ Radlink
For: |l Semens 1 LOCAL PACS
[ Laser Pro 16 Send To: | pr, Jim Bob
With These Properties
Referring: I
Institution: I
Body Part: I
—Apply This Rule At These Times

Recurring Day:

Date:

Between Dates:

Between Times:

Between Date Times:

Send all messages from:.
Always apply this rule.
Save And Exit
| 4
Figure 3-112 — Date Range selection choices
For this example between Date Times is chosen:
|
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Radlink Rule Editor _ ||:||5|

Rule Name: [The Jim Bob Rule

Send To These Locations From The Selected Modality

vl GE [1 Radlink
For |Cl Semens [ LOCAL PACS
[1 Laser Pro 16 Send To: | pr, Jim Bob

With These Properties

Referring: I[)r, Jim Boh
Institution: IZuunty Hosptial
Body Part: IFuut

—Apply This Bule At These Times

Between Date Times: v| [11/24/2003 =l | 1:52:00 Pm

11

{11/30/2003 =l | 75200 AM

EE

Send all messages from: GE to: Dr. Jim Bob, and having referring=Dr.
Jim Boh, and Body Part=Foot, and Institution=County Hosptial.
Apply this rule between 11242003 at 1:52 PM and 11/30/2003 at 7:52 AM.

Save And Exit I

Figure 3-113 — The Jim Bob Rule

5

As the rule is being formulated, the English translation is displayed at the bottom of the
screen. Another example rule is:
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¥ GE = Radlink
R TTIT T O LoCAL PACS
= Lsmer Pan 16 0. Jim Bl

Figure 3-114 — Recurring Day Rule

The completed list for our example is as follows:
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Agpldy this relbe Bedwnan 328 PR ased 726 A daily.

East Valley Rabe: B
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Figure 3-115 — Example Rule Set

To read though the rules in a convenient manner, click the rule filter to just see the rules
by a particular modality or a particular destination:
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Figure 3-116 — Rules filtered by modality
The rules filtered by destination look like this:
=10l =
leuchisns | Destmtions | Mptaitios || Aules Router Stans |
Hule Filter
B8 Bules © For s Modality = For s Destination
Aules m Lo
’ﬁnlu. Ead Flule RANT Fisle:
SIWF Flule Sl 2l Siebssiepts Maim: GE, and Seastss seed Lastd Pio 16 162
After Hours iile Rasiiiad.
Eazt Valliy Hule Agpdy this nele sunny Mesdyy, and Wielsesdsy, and Fridey.

E@fue |  CresteBule | Dolow Rele |

Figure 3-117 — Rules filtered by Destination
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One can view the status of all messages entering the router and which rules were
applied by clicking the Router Status tab.
(Wr oot cadabiy e alol =l

MRadlink

lecuctiran | Destnssions | Modaities| Pubes || Rewter States

Modaliny: | ETEITRD -  RulesTost |

Modality Lesg

I | Patinnt R Pasient Wi | Datn Time  Ststes
] 12 WP UG 102118 1 2AE 123548 »

|

Figure 3-118 — Router Modality Message Log

The Modality combo box should be used to select the modality log for the desired
modality.

To test the rule sets, simply click the Rules Test button. This will simulate sending a
message to the router and applying all of the rules against it. The Dicom file utilized in
the test is “Test.DCM”. This file is located in the “Modality InBox” directory, which is
located in the program files directory for Radlink. You may replace this file with any
Dicom File. The file must be renamed to Test.DCM, however.

To view the files that are being sent to the various destinations, close the Router Screen
to return back to the following screen:
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E Radlink Dicom Routen
File Edit Login Help

Dicom Transfer Progress [

Host/Queue I v | | Pending v

Dicom Destination Queue
- Patient Mame | Patient ID | Description | File Size | Date | Priority

Sendersidle |  Receiversidle |  HoSend Errors
Figure 3-119 — Radlink Router Destination Status Screen

All files being sent are routed through the DICOM Router. The status of the image
may be viewed by displaying the Router Status window. To display the window,
click on the Radlink Icon on the lower right corner of the computer screen.

The status bar gives a instant look at which modality is currently sending to the
Radlink Router, which PACS host the router is currently sending to, and how many
images have been sent to the cancelled directory due to transmission problems. In
addition, the sending status is broken down to not only show activity, but to display
exactly what the router is doing during the image send. The possible send status
states are:

Preparing Images — This indicates that the router is compressing the images for
transmission.

Sending Images — This indicates the router is currently sending the study. The
progress bar at the top of the screen shows the progress of the transmission for
each image being sent in the study.

Retry In Progress — If a transmission occurred, the Router will retry the send for a
user defined number of times.

Send Complete — The study has been sent successfully.

Moving Images to Archive — The images are being moved to the image archive.
This message occurs after a successful send if the check box “Archive?” is checked
on the destination settings screen. If this check box is not checked, the images are
simply deleted after the successful send.
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Deleting Images — The image are deleted after a successful send if the check box
“Archive?” is not checked.

Send Aborted - If the user checks the button “NO” in response to the dialog box
asking the user if he wants to retry the study send, this status is given.

Finished — The send operation has been totally completed.

Senders Idle — The Senders are idle and not sending images.

E Radlink Dicom Routen
File Edit Login Help

Dicom Transfer Progress | |

HostiQueue |eﬁ|m v| | vl [ Resena | [Detete Files |

Dicom Destination Queue
- Patient Mame | Patient ID | Description | File Size | Date | Priority

Sendersidle |  Receiversidle |  HoSend Errors

Figure 3-120 — DICOM Router showing Resend and Delete Files
Buttons on the Cancelled Screen
Compression/Decompression is also supported by the Radlink Router. One should set
the compression algorithm for each destination to perform the compression:
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ﬂ Radlink Modality Router, Q@g

Instructions Mudalities‘ Destinations Rules| Router Status

Destination Settings

Host Name efilm “
Destinations IP |127.0.01
InuEhack Port |4006
Centricity Client AE Title |AE_WINFX
efilmwint Host AE Title |EFILM
# Retries |2
Protocol |DICOM 3.0 b

Compression

noCompression w
Prompt On Send Failure

[ ] Archive ?

e e (Bl tu C'\Documents and Settings'All Users\Documents'e D

[ New ] [Delete ] l Save And Exit l lDicnm Pingl [%

Figure 3-121 — Radlink Router Destination Settings

As messages are received into the Radlink Router, they are decompressed. The
compression algorithm specified for each destination is then inspected. If the Depth in
the settings is less than the depth of the received image, that depth setting and
compression algorithm is utilized, otherwise the compression algorithm specified and
the Depth of the incoming image is used for the outgoing compression.

One can simply receive, archive, and not send an image sent to the Radlink Router.

Simply set up a Modality that the router is to receive images from and then select the
Archive No Forward option:
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B Radlink Moda lity Router

Instructions || Modalities Destinatiuns| Rules| Router Status

Modality Port Settings

Modality Name \ Efilm v

Router AE Title AE_LAPTOP

Port| 108
[ Archive - No Forwarding

WinFX Modality AE Title EFILM |
|
|

Delete ] [ New If Ho Rules Apply, Send to These
Default Destinations

[]loophack
efilm
[] Centricity

[ efilmwinfx

[ Save And Exit ]

Figure 3-122 — Radlink Router Modality Settings

Images will then be received and archived, but not forwarded to any destination
Changing the priority of a study is accomplished by first clicking on the desired study

then changing the priority by clicking on the “Study Priority” combo box and choosing
one of the three priorities:
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Figure 3-123 — Changing a Study Priority

Multiple PACS hosts are supported in the Radlink DICOM spooler. One can view
the status of the DICOM transfers for a particular host, by selecting the host on the
leftmost combo box in the DICOM router screen. All of the operations mentioned
above are available for each individual host in the combo box. Note the
communications are concurrent. Multiple destinations are sent images concurrently.
Also, one host could be paused while another is transferring. In addition, the
DICOM Transfer Progress bar displays the file transfer status (percent complete) for
the particular host selected in the host combo box.

The status of the host is displayed at the top of the file list. The two settings are
“Active” and “Not Spooling Images”. “Not Spooling Images” means that the host has
been set Inactive in the Radlink application. When an image is scanned and sent, it
is only sent to Active Hosts. The image will be sent to all hosts marked as active.

One can view the history and status of all sent images by selecting “Sent” in the
Queue combo box.
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E Radlink Dicom Routen
File Edit

Login - Help

Dicom Transfer Progress [

HostiQueue |ef||m

v

Dicom Destination Queue

Patient Name

ALBERT "BAREBARA
AMORADE "ELIZABETH
APOLIMAR"GRASIAND
BELTAIRE. MaREK Il
BELUEDORN“JOHM
BORGES"COREEM
CAMPEELL™ROY M/50
CAPOYWILLAMIKE
OVERHOLT "BARBARA
PRATHER, &LLEN
RAMOS “NORMA
STOWERS DIANE
STOWERS " DIANE
ULLOA™MARLA

WIERSEMA™RATHERINE

Patient I
551761758
00010133
OEEET0
B08E45337
279289521
1403397
TOo1 43421
HE82E9340
445302405
453-23-320
000734528
RE2407370
REZ2407370
3921
BO0AE23724

v
[ escription
ce angio”Carotids
ABD PalN
CHEST w0
l-spine " Toutine

long bone fermur

Abdomen™ DUAL PHASE
Abdomen™ BODYVIEW

l-spine"rautine
pelvis"female
[u]]

REMAL STOME

File Size

Date

12A10/2004 8:51:20 &M
121042004 8:50:36 AW
12A10/2004 8:50:25 AW
121042004 8:45.53 AW
12A10/2004 8:45.48 &AM
121042004 8:45:08 AW
12A10/2004 8:48:18 &M
12M0/2004 84512 AW
12A10/2004 8:46:56 AW
121042004 8:43.50 AW
12A10/2004 84329 &M
12M0/2004 84322 AW
12A10/2004 84251 AW
121042004 8:41:04 AW
12A10/2004 8:40:44 AW

Senders Idle

Receivers ldle

Ho Send Errors

X

Priority =

Succes
Succes
Succes
Succes
Succes
Succes
Succes
Succes
Succes
Succes
Succes
Succes

Succes w
»

The above figure is the status of all files sent to the host with host alias “efilm”

Figure 3-124 — DICOM Router Communications File Status

. The list

of files can be sorted by clicking on the column header. The list can be sorted on any

column, ascending or descending. The following figure is the same list sorted by time in

ascending order:

I-I
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Patient Marme

ﬂ Radlink Dicom Routen @

File Edit Login Help

Dicom Transfer Progress | |

Host/Queue | efim

Dicom Destination Queue

Patient Mame Patient [0 [ escription File Size Date & | Prionty «
4 ALBERT "BAREBARA 551761758 head routine 10/25/2004 2:08:36 PM Succes
ALBERT "BARBARA B517E1758 head "routine 10/25/2004 2:08:49 PM Succes
ALBERT "BAREBARA 551761758 head routine 10/25/2004 2:08:59 PM Succes
ALBERT "BARBARA B517E1758 head "routine 10/25/2004 2:05.26 PM Succes
GIACHETTI™JOSEPH 1403359 pelvis male 10/25/2004 210:51 PM Succes
FRIESS. KaY 454-77-9568 HEAD "w/ w0 10/25/2004 211:20 PM Succes
ALBERT "BARBARA 551761758 ce angio"Caratids 10/25/2004 21239 PM Succes
COOK"MINMIE 136044 ABD PN 10/25/2004 21309 PM Succes
AMDRADE "ELIZABETH 000810193 ABD PalN 10/25/2004 21315 PM Succes
APOLINARTGRASIAND OEEEF0 10/25/2004 21401 PM Succes
BELTAIRE. MaRK 1Nl EOBE46337 CHEST w0 10/25/2004 214:26 PM Succes
BLUEDORN™JOHM 279289521 l-zpine"rautine 10/25/2004 21551 PM Succes
BORGES"COREEM 1403397 long bone " fermur 10/25/2004 21738 Pt Succes
CAMPBELL™ROY M./50 TO0 43421 10/25/2004 21751 PM Succes
CAPOVILLA™MIKE REA2E3340 Abdomen™ DUAL PHASE 10/25/2004 215:25 PM Succes w
4| | LH

Receivers ldle Ho Send Errors

Figure 3-125 — DICOM Router Status Sorted By Time of Day

Senders Idle

Log files are generated to track the activity of the Radlink Router. There is one log
file for each DICOM destination. The log files can be easily imported into Microsoft
Excel for formatting and subsequent printing. The file name of the log file is
“Radlinklog-<host alias>.txt” where <host alias> is the user defined name for the
DICOM destination. These log files are placed in the Radlink.exe home directory,
which is typically c:\program files\eradlink. Note that columns are tab delimited for
ease of use in Microsoft excel. The following is an example report formatted in
Microsoft Excel:

Radlink Spooler DICOM Communications Log File - Host Alias "Default™

D Ui PACS IP PORT File Name Staius Date/Time

seriestest 1234 1.2.392.12345.1.2003.4.1.8.52.50.563  weww. eradlink.com 108 1.2.392.12345.1.2003.4.1.8.52 50563 Success 44103 §:53 AM
seriestest 1234 1.2.392.12345.1.2003.4.1.8.52.53.5976  www eradlink.com 108 1.2.392.12345.1.2003.4.1.8.52.53.976 Success 4/1/03 5:53 AM
seriestest 1234 1.2.392.12345.1.2003.4.1.8.52. 55723 www eradlink.com 108 1.2.392.123451.2003.4.1.8.52.55.723 Success 44103 5:53 A
seriestest 1234 1.2.392.12345.1.20053.4.1.853.0.441  wwaw eradlink.com 108 1.2.392.1234512003.4.1.853.0.441  Success  4/1/03 5:53 A
setiestest 1234 1.2.392.123451.2003.4.1.855 52276 wwaw. eradlink.com 108 1.2.392.123451.2003.4.1.85552 276 Success 40103 5:56 Al
seriestest 1234 1.2.392.12345.1.2003.4.1.8.55. 54,605 www eradlink.com 108 1.2.392.12345.1.2003.4.1.8.55.54 605 Success 41103 5:56 Al
seriestest 1234 1.2.392.12345.1.2003.4.1.8.55. 55,920 www. eradlink.com 108 1.2.392.12345.1.2003.4.1.8.55.55.920 Success 4/1/03 5:56 Al
seriestest 1234 1.2.392.12345.1.2003.4.1.8.55 589596  www eradlink.com 108 1.2.392.1234512003.4.1.8.55.59.996 Success 47103 5:57 Al
seriestest 1234 1.2.392.12345.1.2003.4.1.1006.37 126 wwaw. eradlink.com 108 1.2.392.123451 2003.41.10.6.37 126 Success 4/103 10:06 Al
setiestest 1234 1.2.392.12345.1.2003.4.1.1006.38.913  wwew. eradlink.com 108 1.2.392.12345.1.2003.4.1.10.6.38.913 Success 4/1/03 10:07 Ahd
seriestest 1234 1.2.392.12345.1.2003.4.1.106.45 67 www eradlink.com 108 1.2.392.12345.1.2003.4.1.10.6. 45,67  Success 47103 10:07 Al
seriestest 1234 1.2.392.12345.1.2003.4.1.1006.54.756  www. eradlink.com 108 1.2.392.12345.1.2003.4.1.10.6.54. 756 Success 4103 10:07 Al
Figure 3-126 Dicom Router Log for Host “Default”
I-I
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A status column is included to indicate the success/failure of the DICOM send. The
Radlink Router has been modified to display most of this log file information.

Lastly, an interface for perform Radlink Archive Database Maintenance functions is
provided. This screen is activated by clicking the menu item File->Database

Maintence:
E Radlink Archive Maintenance g@@

Purge files we | Days
older than: ﬂ

( |

Archive | m\Nocyments and Settingshall
Directory S E
Sync. Database

Backup
Database

Delete+Restore
Database

Purge Old Files

Exit

Figure 3-127 — Radlink Archive Maintenance

The “Purge Files Older Than:” drop down list is the number of days that
images will be retained in the Archive before being automatically deleted.
This retention policy also applies to log file entries. Thus all logging entries
older than that period will be removed as well.

The “Sync. Database” button should be used to synchronize the database
tables based upon the current image directory contents. This action can be
lengthy depending upon the number of images in the archive. The progress
bar on the screen with a “number of files” counter displays the current status
of the database synchronizing process.

The “Archive Directory” location can be changed by clicking the Folder Icon
to the right. Changing the Archive location will automatically synchronize the
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database based on the new archive directory contents. Please note that this
capability previously was located on the destination settings screen.

The “Backup Database” button will backup the SQL database. It is useful to
periodically backup the database as most user settings are contained in the
database. The backed up database is called “Backup” and is located in the
Radlink installation directory (Typically c:\program files\eradlink\backup”.

The “Delete + Restore Database” button is used to restore the database
from a previous backup. The action deletes the current Radlink Database
then restores it with the last backup. The backup file is called “backup” and is
located in the Radlink installation directory. The database is automatically
synchronized upon the completion of the database restore process.

The “Purge Old Files” button purges images and log file entries older than
the retention period. This action is automatically performed upon Radlink
application startup. It is also automatically performed once per day in
unattended router operation.
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Chapter 4

ImageExpress™

for Remote Retrieval of DICOM Studies
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Chapter 4: ImageExpress™
for Remote Retrieval of DICOM Studies

Search DICOM Files
Downloading of files is asynchronous to the Radlink application. One can
access this functionality by either clicking the “Radlink Image Express” icon
on the desktop or by selecting “Search Server Files” from the file menu in the

Radlink application.

[revy e

Figure 4-1 — Activating Radlink Image Express

The following figure is the main screen for Radlink Image Express:
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Figure 4-2 — Radlink Image Express

The bottom left of the screen is the status of the Image Express application.
The five application states are:

- Idle. There are no images remaining to download.

- Waiting For New Images - Image Express is polling the server for new
images.

- Radlink Connection In Progress. The Image Express application is
logging into the Radlink server.

- Compression In Progress. Image Express is compressing the image
for download.

- Download In Progress. The DICOM file transfer is currently in
progress. The percentage of the file that has been downloaded is
shown in the Transfer Status progress bar at the top of the screen.

- Decompression In Progress. The Radlink Image Express application
is decompressing the image.

The files are downloaded to the Image Archive Directory and can be opened
in the Image Acquire Open Archive screen..

The user name and password are assigned by your account administrator.

|’m USER MANUAL Page 153

Radlink



E Radlink Login

Radlink Server Login

User Name: | |

Password | |

[ Login ] [Cancel ]

Figure 4-6 — Server Login

FEENNL e w . . L E e .
] e v
o
Dy |iiead 0 Werrwy Enams
Hesume Vi M Fis T

Figure 4-7 — The Radlink Search Screen

After one logs into the Radlink Server, the Radlink Search screen appears
with the files uploaded that day. To view all files, unclick the “From:” check

box. This will display all files uploaded to the Radlink folder before and
including today.

|’m USER MANUAL Page 154

Radlink



I Radlink Ssarch

L Hame: [ P
et = T
TR S &
e sy 3 e Lol c i [ T=:
b s
(5 Wisw E v
D e i

| 3 Vocialfy | Fubiank Hara: FabwiD:  Evhdan [— Fatarg FiaSon | Daix -
k
: 1228501 T35 [OD0CE 3004 BA 11 5T 1098 oC BT, SHELLENE 107 D g T CARTON 24p1208 DEDACTON

1.3 300 a5 GG 00 DT 1605 S5 B £:ARTER, BHFLEY A0TED LCUELE T ] HICE AIEAEDE N0

123601 7348 DMOSE 20 105110894 50 FARPISH, HETH AT OTENEs SHePECK I7BIGE 10 215004

1.2 3601 2345 IG0G26 3004 720 143 471 or REED, MECAHE a5k DSBS BOORARALA AMEEED (TG0

122801 T35 [OD0GTE 2004 85,11 211681 5C SMITH, ANTHORY DE30 18 DANEN 53 PALLEY STID DEEGTON

1.3 2600 05 EGee 004 837 1204 2689 Uz W VR 02200 1133 EErAALA, dEEE0E DRG0

122801 T3 [OD0GTE: 3004 B3 154 28 NH SC WWOOLEY L, [.-1. . 3] 110N 31 LEAYEWRSORTHIC 145574 DENTLGTON

12 3001 20a5 DEGE N0 B 11 3 3R] BE in & FEEMEY HE  1080A317 By S R

1228001 T35 [OD0CE 2004 B4 1141 A7d oC MCAFIC MRS, 107022 ot ok ] CEAFTYEOHN JEXSEDE D411 GO0H

1236012095 IR 0 B 12 M ITIE  US ACCETTA, WATTHEW TZES  DSHIEN CRREOR AERTID DRG0

123601 7345 DOOOSE 300 27111 5693 = ADAHE, ELICAEETH [T e BMACY  PHOM DR  [OATGIOH

1.2 2621 2305 IEEe 00 T L1 SR B AlENZ, ELIZLEETH DLET. DR DEGEEE EBERAAL AT TYE  dE1T1EE  [0WDH 200

122801 T3 [OD0GTE: 3004 7 5,17 45 4861 SC SOANT, FLICASETH DOAaT oe arndnaa BFTALCY BOs-1500 TDZESE  [OVLGTON

1.0 S8 a5 DGR 00 X D A0 E2H) B alehiz, ELIZAEETH DT & LEGTEE ] AR AMDETED DA 2004

122001 T345 [OD0CE 2004 817 H 258 cr SOANT FLICASETH DOAT DB arndnan BTACY Do 1B00 2N S [N

1236012095 IG0EE 2004 FA T BE AN 5O ADeREEITABETH WaTe  OTANEH BRIMARALAKAR TG0 [REI0

12,2601 T35 DOO0SE 3004 7 32104414 = AGAASH, HERTHE T 1S ey M EEI
L ¥

Figure 4-8 — The Radlink Search Screen
The Search Screen file list can be sorted. Simply click on the column header

above the column that is to be sorted on. This will be useful for rapidly finding
a particular DICOM file. The default sort is on the Patient Name.

Search by Date
Searching for files by date is also supported. To search for files within a date

range, simply click the drop down In the From box and pick the date you wish
to search on:
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Figure 4-9 — Date Selection Technique

The result of clicking the drop down on the From Date is shown above. To
select a date, simply click the desired date. That date will then fill into the
date field.

To enable the date search criteria, you must check the check boxes. To
ignore the date selection, uncheck the check boxes. To select all files newer
than a particular date, check the From box and enter the date and also
uncheck the To Date check box. To find all files older than a particular date,
uncheck the From Date check box and check the To Date check box. To
find all files in a range of dates, check both boxes and fill in the appropriate
dates as shown above.

Search by Name

If you wish to find all patients whose name starts with Thom, type Thom into
the name field and push the Search button.

Search Results

Figure 38 shows the results of a sample search. In the example, all DICOM
files for patient glenn over all dates will be returned. Please note that the
search is case sensitive. Also note that the date check boxes were
unchecked so dates weren’t included in the search criteria. Other search
criteria can be selected as well. Patient ID, Accession number and Referring

U

Radlink
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Physician are also supported. If any of the criteria field boxes are left blank,
they will be ignored in the search.

Figure 4-10 — Results of Example Search for Patient seriestest

If the file selected has no compression, a variety of compression choices are
available at the lower left part of the screen. If one chooses a DICOM
compressed format, the file will be compressed, transmitted to the
workstation, then uncompressed at the workstation. If the file selected is
already compressed, no compression or decompression will take place during
or after the file transfer and the combo box for the download compression
type is disabled.
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File Transfer File Options

As shown in Figure 4-10, there are 3 compression types:

DCM Uncompressed — 16 will download the DICOM image from the
Radlink server with no compression or image alteration.

DCM JP2000 Lossless compression — Lossless 16 bit wavelet compression
yields between 3 and 5 to one compression ratios.

DCM JP2000 Lossy compression — Compression ratios from 5 to one to 40 to
one are achieved with lossy 16-bit wavelet compression. A compression ratio of
30 to one with no perceptible loss of image quality is typical for most images.

Fieleming W0 = Te
[ covis =
[

Cvmarm (o]

Figure 4-11 - File Transfer File Options
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Figure 4-13 — Selecting an Exam For Download
Figure 4-13 shows one file has been selected for download. One selects a file
for download by clicking the gray box to the left of the desired file for
download. One can select multiple files for download by holding down the
“CTRL” key and selecting multiple rows. To select a range of files to
download, first select the first file to download then hold down the “Shift” key
and select the last file in the range of files to be downloaded.
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Figure 4-14 — Multlple File Selection
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In the above figure, all images for a particular exam have been selected for
download. The setting for the compression technique to be used in the
example above is “jpeg2000Lossy”. Other settings are shown in the following
figure:
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Figure 4-15 — Download Compression Settings

After the files are selected and the proper compression settings are set, click
the “Retrieve Files” button. The files will immediately start downloading.
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Figure 4-16 — Download In Progress

The range of files to be transferred is then displayed with the top row being the
file that is currently being transferred. The compressed file size and the
compression technique being used are shown for the file currently being
transferred. The percent complete for that file is also displayed in the progress
bar. After the file is transferred, it is removed from the list and added to the
Downloaded files list. When all files are transferred, the list becomes empty and
you can then click “Browse Host Files” to retrieve more files. Note that this
example described retrieving a series of images for a particular exam. One could
retrieve any set of images desired for retrieval using the Radlink Search screen.

If Image Express is left running unattended, as images are uploaded to the
Radlink Image Central, they will be automatically downloaded.

One can also view exams and download all images for the selected exams:
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Flgure 4-17 - Viewing Images by Exam
To download all the images for the selected exam, as shown above, click
Retrieve Files. To view all images, click the radio button, “View All Files”.
The following is the result of doing so in the above example:
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Figure 4-18 — Viewing AII Images

In the above figure, all images are listed. One can select specific images for
download with the radio button “View All Files” selected. As shown, there are
4 images in the Exam for Patient Name “seriestest”. If one clicked the button
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Retrieve Files button in Figure 1 above with the radio button set to View
Exams and with “seriestest” selected, the following screen would appear:
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Figure 4-19 — Download of the “seriestest” Exam

When all images are retrieved, Image Express will begin polling for new images.
It is important to note that the polling does not commence until the Browse Host
Button is clicked. That action will allow one to log into the server and establish
the connection. One does not have to select any files to be downloaded to begin
the polling process, however.
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Chapter 5: Image Central™ Web Service
and the Browser Based Viewer

The Radlink Web Site and Account Management

User Account management is facilitated with the www.eRadlink.com web site.

Log into the Radlink web site by clicking login on the left side of the Home
Page:

eur Mediow breegng Aekion

A e

Figure 5-1 — www.Radlink.com Home Page
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Figure 5-2 — www.eRadlink.com Login Page

The user name and password are the same as logging into the Radlink server
from the Radlink application. The user name and password was generated by
your Account Administrator.

Each user in the Radlink system has one of two levels of entitlement. The first is
Account User. The second is Account Administrator.

The following describes the screens for the Account Users and
Administrators.
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Figure 5-3 — Radlink Main Screen

After logging in, the system will take you to the above screen. There are 6 menu
items on the left side of the screen. Home will take you to the Radlink Home
Page. You are not logged out when going to the Home Page. To get back to the
Radlink Main Page, simply choose login again from the Home Page and you will
be taken there without the need for logging in again. To log out of the Radlink
web site, click on” Log Out”. For security reasons, the password should be
changed after the first time you log in and periodically thereafter.
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Figure 5-4 — Radlink Change Password Screen

You should make the password at least 6 characters long and include a numeric
and also a special character such as an exclamation point.

You need to enter the password twice. If they match, your password is updated
after pressing the update button. You can view and update your profile
information by pressing the User Profile Menu Item on the left side of the screen:
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Figure 5-5 — Radlink User Profile Screen

Please update the your profile information as needed. This is done by pressing
the Edit Profile button. The email information is especially important. Major

changes and release announcements will be communicated to you using your
email address.

To view your account profile information, click on the Account Profile menu item
on the left side of the screen.
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Figure 5-6 — Radlink Account Profile Screen
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The Account Administrator is listed as the Account Owner. In the above example
itis A. Demo. The phone number for support is also listed. The client ID is the
client title that you need to specify in the user preferences screen of the Radlink

Application as shown in figure 44 above.
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To view contact information of all users in your account, push Users on the left
side of the screen:
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Figure 5-7 — Radlink Users Screen
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The following section applies to Account Administrators only:

To view the users in your account push the Users menu item on the left side of
the screen:

PRSI O -
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Figure 5-8 — Radlink Users Screen

Account Administrators will see three buttons enabling them to edit, create, and
delete users. To create a user, push the create user button.
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Figure 5-9 — Radlink Create User Screen

B ke

2,

The user name is the user id the user will use to log into the web site and the
Radlink Application. It must be entered and should not contain any spaces. The
password must also be entered. You need to communicate the user name and
password to your new user. It is also highly recommended that you enter the
user’'s email address. The other fields are optional, but it is recommended that

they be filled out.

To edit a user’s profile information, the user must first be selected on the users

screen.
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Figure 5-10 — Radlink Users Screen

To select a user for editing, push the > button to the left of the desired user.
When a user is selected, the edit user and delete user buttons are enabled and
the selected user is highlighted. To edit the user, push the edit button and edit
the user as described in the edit user section earlier in this document.

To delete a user, push the delete user button.
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Figure 5-11 — Account Profile Screen

rl-l

To edit the account profile information, click on the Account Profile button on the
left side of the screen and push the Edit Profile button:
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Figure 5-12 — Edit Account Profile Screen

The Account Information should be completely filled out. The Account Owner
and Client ID cannot be modified. You need to call Radlink to make changes to

these fields. To persist the changes to Account Information, push the Update
button.
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To view server usage statistics, click “Accounting” This displays the montly totals
of images sent to the eradlink server and images downloaded both by image
express as well as by web pages:
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Fmei™ | PACS Usage - Monthly Totals
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Figure 5-13 — PACS Usage Statistics

The totals are displayed by month and show totals for:
1- Studies sent to the Radlink Server.
2- Images sent to the Radlink Server.
3- Images viewed by the Radlink Web Server.
4- Images downloaded by Image Express.

The Radlink web site also has image viewing capabilities. One can view the
Exams for his account by logging onto www.Radlink.com and clicking “Exams”
on the left side of the web browser.
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Figure 5-14 — Patient Exams Screen

One can view the Exam information by selecting the desired exam and
clicking “View Exam”. These exams can be sorted by Name, UID, Date,
PatientID, or Modality as shown in the above figure. To select an exam, push
the “>” button on the left of the row containing the desired exam.
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Figure 5-15 — Viewing Exams at www.Radlink.com

In the above figure, the exam for patient “seriestest” has been uploaded to the
Radlink server. User A. Demo has logged in and has selected that exam for
viewing. He then selects image 2 by clicking the > button. The following
screen then appears:
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Figure 5-16 — Radlink Web Image Viewer

One sets the window level by selecting Image—>Adjust->Window/Level menu
item in Image J:
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Figure 5-17 — Selecting Window/Level in ImageJ

After selecting window level, the following applet window appears:
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Figure 5-18- Window Level

One then moves the sliders for window/level to obtain the desired
window/level setting:
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Figure 5-19 — Image After Setting Window/Level
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Appendix

Table 6 — Hardware Specifications

Film size Min: 2 inch x 2 inch
Max: 14 inch x 15 feet
Scan time .5K mode — 6 seconds

(147 x 177 film) 1K mode — 12 seconds

2K mode — 25 seconds

3K mode — 37 seconds

Interface USB or Ethernet
Dimensions 18”(w) x 127(d) x 12”(h)
Weight 26 Ibs.
Power Input voltage 85 to 264 VAC
Input frequency 47 to 440 Hz
Input current 3.2A for 115 VAC 60 Hz

0.9A for 230 VAC 50 Hz

Internal voltage/current | +5 V at 10A max

+12 V at 1A max

-12 V at 1A max

+24 V at 5A max

Laser Type Solid State
Power 35 mw
Resolution Spatial 3072 pixels over a 14 inch scan line
Grayscale 16 bits
Optical Density 0.00 to 4.00 Transition | 5 pixels or less
range of density
Signal-to—noise |4to1at0to4.0 0.001 O.D. at density 1.5 O.D.
ratio Optical Density

0.01 O.D. at density 2.5 O.D.

0.1 O.D. at density 3.5 o.d.

Geometry ? one pixel of true position over
entire film

Pixel output 3K scan line 3072 pixels over 14 inches

Modes

Output format (All scan modes) 8,12 or 16 bit (65,536 grayscale)

Gamma tables 16, 12 or 8 bits Programmable LUT

Default: linear (to O.D.) 2
programmable




Table 7 — Error Conditions and Actions

Error Condition

Action

No power to the
scanner

Check that the Power Switch on the
scanner is “ON”.

The Power Supply has a number of
protection circuits which sense “over
voltage”, “over current” and “input surge
protection”. Any of these conditions will
cause the Power Supply to trip a fuse. Call

Radlink for further action.

Film Jam

Unlatch back panel. Remove film, close
panel and replace film. Scan will continue.
If the problem persists, check the film for
labels or tape which can cause uneven
feed problems. *

Vertical black lines

Check the film for lines. If O.K., unlatch the
back panel and wipe a soft cloth dipped in
alcohol across the Sensor PCB to remove
dirt. Close panel and scan again.

Film feeding unevenly
(skewed)

Turn scanner power off. Unlatch the Back
Panel. Remove film and check for labels or
tape. Check the Feed Rollers for dirt. Turn
Power On, close Back Panel and replace
film. Scan will continue.”

e |If a problem persists, call Radlink Customer Service for guidance.




HIPAA and the Advanced Encryption Standard

The Radlink system addresses HIPAA security requirements

eRadlink
TeleRadiology Servers
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The preceding diagram illustrates the security components of the Radlink
system. The following items describe each component illustrated above
1. Radlink Web Browser — The web interface to the Radlink Web Server is

now utilizes the Secure Socket Layer (SSL) and enforces 3DES
encryption. All transmissions to the web site, including images, are
encrypted.



. Radlink Image Express — Image express now utilizes the Advanced
Encryption Standard, Rijndael Symmetric encryption for all
communications to the Radlink DICOM server. Once DICOM images are
downloaded, they are automatically unencrypted and can be imported into
third party DICOM viewers or opened with the Radlink application. No
firewall is shown in the figure for Image Express. If one is needed, an
inexpensive Network Address Translator (NAT) could be utilized. Firewall
functionality comes standard with Windows XP Home and Professional.

. For compatibility with other systems, unencrypted DICOM
communications will continue to be supported. DICOM communications
from applications such as eFilm are supported. In addition, DICOM
communications to PACS servers from the Radlink DICOM spooler is
supported as before.

. The Radlink DICOM spooler will now encrypt all communications to the
Radlink DICOM Server using the Advanced Security Standard Rijndael
Symmetric encryption algorithm. For installations that wish to transmit
images from other Modalities, a Modality Router is added to the Radlink
system. This feature will accept all images from various modalities and
forward them encrypted to the Radlink DICOM Server utilizing the DICOM
Spooler. Images could also be forwarded to unencrypted servers such as
a local PACS server using the Modality Router and the Radlink DICOM
spooler.

. The Radlink servers are secured using the HIPAA security guidelines as
written by Microsoft. These guidelines are in the following sections with
the details of the Rijndael encryption algorithm.



